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Introduction

IBM® Predictive Customer Intelligence gives you the information and insight that
you need to provide proactive service to your customers. The information can help
you to develop a consistent customer contact strategy and improve your
relationship with your customers.

Audience

This guide is intended to provide users with an understanding of how the IBM
Predictive Customer Intelligence solution works. It is designed to help people who
are planning to implement IBM Predictive Customer Intelligence know what tasks
are involved.

Finding information

To find product documentation on the web, including all translated
documentation, access IBM Knowledge Center (http://www.ibm.com/support/
knowledgecenter).

You can also access PDF versions of the documentation from the Predictive
Customer Intelligence web page (www.ibm.com/support/
docview.wss?uid=swg27041723).

Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products. Some of the
components included in the IBM Predictive Customer Intelligence have
accessibility features.

IBM Predictive Customer HTML documentation has accessibility features. PDF
documents are supplemental and, as such, include no added accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.

Samples disclaimer

Sample files may contain fictional data manually or machine generated, factual
data compiled from academic or public sources, or data used with permission of
the copyright holder, for use as sample data to develop sample applications.
Product names referenced may be the trademarks of their respective owners.
Unauthorized duplication is prohibited.
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Chapter 1. IBM Predictive Customer Intelligence

IBM Predictive Customer Intelligence brings together in a single solution the
ability to do the following tasks:
v Determine the best offer for a customer.
v Retain customers that are likely to churn.
v Segment your customers, for example, by family status and salary.
v Identify the most appropriate channel to deliver an offer, for example, by email,

telephone call, or application.

This solution ensures that all interactions with customers are coordinated and
optimized. Predictive customer intelligence gives you the ability to sift quickly
through millions of subscribers and know who to contact, when, and with what
action.

The following steps define the process:
1. Understand the customer. Predictive modeling helps you to understand what

market segments each customer falls into, what products they are interested in,
and what offers they are most likely to respond to.

2. Define possible actions and the rules and models that determine which
customers are eligible for which offers.

3. After the best action is identified, deliver the recommendation to the customer.

Integration with the IBM Enterprise Marketing Management
(EMM) suite

IBM Predictive Customer Intelligence integrates with the following solutions:
v IBM Campaign, a web-based solution that enables users to design, run, and

analyze direct marketing campaigns.
v IBM Interact, which provides personalized offers and customer profile

information in real time.
v IBM Marketing Platform, which provides security, configuration, and dashboard

features for IBM EMM products.

IBM Predictive Customer Intelligence provides two connectors between IBM
Interact and IBM SPSS® Collaboration and Deployment Scoring Service:
v The External Callout connector calls an IBM SPSS model at run time, and is

contained within the expression of an advanced rule for a marketer score,
overriding the score that is supplied by the EMM campaign.

v The External Learning connector extends IBM Interact's native learning module
to monitor visitor actions and propose optimal offers. It prioritizes IBM
Campaign offers based on an IBM SPSS model's prediction of their final score.
The connector passes specific configurable parameters as input to the IBM SPSS
Scoring Service.

Integration with the IBM Next Best Action Optimizer

IBM Next Best Action Optimizer (NBAOPT) segregates customers by lifetime
value, and then provides recommended actions to retain customers, which are
based on their lifetime value segment.

© Copyright IBM Corp. 2014 1



You can integrate NBAOPT with the IBM Predictive Customer Intelligence
solution. Install the NBAOPT connector to add an NBAOPT item to the IBM SPSS
Modeler Tools menu. You can start the NBAOPT Studio from this menu, and you
can generate a stream from PMML files.

Solution architecture
The IBM Predictive Customer Intelligence solution uses several different nodes,
where each node provides a specific function for the solution. Each node represents
a separate computer or a separate virtual machine image from the other nodes. A
default environment installation of uses four nodes.

The following diagram shows the nodes in the architecture, with the software
installed on each node.

Predictive Analytics node

The Analytics node provides predictive scores and offers recommendations.

This node has the following software installed:
v IBM WebSphere® Application Server Network Deployment
v IBM SPSS Collaboration and Deployment Services
v IBM SPSS Modeler Server
v IBM SPSS Modeler Collaboration and Deployment Services Adapter

Figure 1. Predictive Customer Intelligence nodes
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v IBM SPSS Modeler Server Social Network Analysis
v IBM SPSS Statistics Server
v IBM Analytic Decision Management
v IBM SPSS Text Analytics Server
v IBM SPSS Data Access Pack
v IBM DB2® Client

Optionally, you can distribute the Analytics node components onto additional
computers in your environment. For example, you can add a node on which only
IBM SPSS Collaboration and Deployment Services is installed. Distributing
components can be done only after you complete a default environment
installation.

Business Intelligence node

The BI node provides dashboards and reports.

This node has the following software installed:
v IBM WebSphere Application Server Network Deployment
v IBM HTTP Server
v IBM Cognos® Business Intelligence
v IBM DB2 Client

Optional components are also available, such as IBM Cognos Mobile and IBM
Cognos Real-time Monitoring.

Integration Bus node

The Integration Bus node processes events, updates the content for IBM Cognos
Business Intelligence, and triggers predictive scoring and decision management. It
also loads master data into the solution.

This node has the following software installed:
v IBM WebSphere MQ
v IBM Integration Bus
v IBM Integration Bus Explorer
v IBM Integration Toolkit
v IBM DB2 Client

data node

The data node provides the database server that contains the databases that are
used by other products in the solution. The database acts as an event store and
holds calculated key performance indicators (KPIs) and profiles. It also contains
supporting master data for the solution.

This node has the following software installed:
v IBM DB2 Enterprise Server Edition

Chapter 1. IBM Predictive Customer Intelligence 3
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Chapter 2. Installation prerequisites and preparation

Before you install IBM Predictive Customer Intelligence, ensure that the computers
that you use meet the minimum requirements for operating systems, prerequisite
software, processing, and disk space.

You must also install additional prerequisite software on some computers,
including the Business Intelligence (BI) node and the Integration Bus node
computers.

Important: The computers or virtual machines that you use for Predictive
Customer Intelligence nodes must not have any of the included software already
installed.

Supported operating systems and hardware requirements
Review the minimum hardware and operating system requirements before you
install IBM Predictive Customer Intelligence. The requirements apply for all
computers or virtual machines that you use for the installation.

Server computers

The Predictive Customer Intelligence server components must be installed on
computers that are running the 64-bit Red Hat Enterprise Linux Server Edition
version 6.5 (x86_64) operating system.

You must have the Legacy UNIX compatibility package installed. The package is
selected when the operating system is set up. The components of this package
must be installed on each computer or virtual machine image on which you install
a Predictive Customer Intelligence node.

Hardware requirements

At a minimum, each computer or virtual machine that hosts a Predictive
Customer Intelligence server component, or node, must have the following
hardware requirements:
v 4 processors
v 32 GB of RAM
v 300 GB of hard disk space

The computer from which you run the installation must have sufficient
disk space that is allotted to the / directory. For the computer where you
are running the installation, the minimum recommended disk space for the
/ directory is 150 GB. Each node computer should have a minimum of 100
GB of disk space that is allocated to the / directory.

Important: If you are installing from the universal serial bus (USB) hard
disk drive, you must have 300 GB of disk space allocated to the / directory.

If you are expecting to store large volumes of data, you might need to
increase your disk size.

Each node must be installed on a separate computer or on a separate
virtual machine image.
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User requirements

You must have root or sudo access to all of the computers on which you
install a Predictive Customer Intelligence node, including the computer
from which you run the installation.

Client computers

The Predictive Customer Intelligence client components must be installed on
computers that run Microsoft Windows 7 operating systems.

Clients can be installed on 32-bit or 64-bit computers. 64-bit is recommended.

At a minimum, each Predictive Customer Intelligence client computer and the
computer where you run the Deployment Wizard for the client components, must
have the following hardware requirements:
v 2 processors
v 8 GB of RAM
v 150 GB of hard disk space

Modifying the sudoers file for the user who runs the
installation

To run the IBM Predictive Customer Intelligence installation you must be either
root user or have sudo permission on each node computer, and you must disable
requiretty during the installation.

To install with sudo user permissions, you must also add the user to the sudoers
file.

Procedure
1. Log in as root user.
2. Enter the following command to open the sudoers file for editing:

visudo -f /etc/sudoers

3. Locate the following line:
Defaults requiretty

4. Press the I key to insert text.
5. Type a number sign (#) in front of Defaults requiretty to comment out the

line. For example, the line should appear as
#Defaults requiretty

6. If you run the installer as a user with sudo user permissions, go to the end of
the file, and add the following line for your user:
username ALL=(ALL) NOPASSWD: ALL

7. Press the Esc key, and enter :wq to save and close the file.
8. Repeat these steps on each computer on which you install a Predictive

Customer Intelligence node.

Installing required operating system packages
Specific operating system packages must be installed on each computer or virtual
machine where you install an IBM Predictive Customer Intelligence node.

Ensure that the following packages are installed:
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v sshpass-1.05-1.el6.i686.rpm

v libXext-1.1-3.el6.i686.rpm

v libXft-2.1.13-4.1.el6.i686.rpm

v libXi-1.3-3.el6.i686.rpm

v libXp-1.0.0-15.1.el6.i686.rpm

v libXpm-3.5.8-2.el6.i686.rpm

v libXrender-0.9.5-1.el6.i686.rpm

v libXtst-1.0.99.2-3.el6.i686.rpm

v compat-libstdc++-33-3.2.3-69.el6.i686.rpm

v compat-libstdc++-296-2.96-144.el6.i686.rpm

v expat-2.0.1-11.el6_2.i686.rpm

v fontconfig-2.8.0-3.el6.i686.rpm

v freetype-2.3.11-6.el6_2.9.i686.rpm

v libstdc++-4.4.6-4.el6.i686.rpm

v libX11-1.3-2.el6.i686.rpm

v libXau-1.0.5-1.el6.i686.rpm

v libxcb-1.5-1.el6.i686.rpm

v libICE-1.0.6-1.el6.i686.rpm

v libuuid-2.17.2-12.7.el6.i686.rpm

v libSM-1.1.0-7.1.el6.i686.rpm

v libXt-1.0.7-1.el6.i686.rpm

v libXmu-1.0.5-1.el6.i686.rpm

v libjpeg-6b-46.el6.i686.rpm

v libpng-1.2.49-1.el6_2.i686.rpm

v zlib-1.2.3-27.el6.i686.rpm

v glibc-2.12-1.80.el6.i686.rpm

v openmotif-2.3.3-4.el6.i686.rpm

You can download the packages from a site such as pkgs.org or rpm.pbone.net.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Type the following command to verify that an operating system package is

installed:
rpm -qi full_package_name

For example, to verify that sshpass-1.05-1.el6.i686 is installed, type rpm -qi
sshpass-1.05-1.el6.i686.

Note: You might have to use sudo to run the command successfully.
For example, enter sudo rpm -qi full_package_name.

3. Install any package that is not already installed.
You must download any missing package, and then install the downloaded
package by typing the following command:
rpm -ihv full_package_name.rpm

For example, to install sshpass-1.05-1.el6.i686, type rpm -ihv
sshpass-1.05-1.el6.i686.rpm.
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4. Repeat these steps on each computer on which you install a Predictive
Customer Intelligence node.

Verifying that the Legacy UNIX compatibility package is
installed

Legacy UNIX compatibility must be installed on each computer or virtual machine
where you install an IBM Predictive Customer Intelligence node.

You must verify that the following packages are installed:
v authd-1.4.3-30.el6.x86_64.rpm

v cups-lpd-1.4.2-48.el6.x86_64.rpm

v dump-0.4-0.6.b42.el6.x86_64.rpm

v finger-0.17-39.el6.x86_64.rpm

v finger-server-0.17-39.el6.x86_64.rpm

v krb5-appl-servers-1.0.1-7.el6_2.1.x86_64.rpm

v ksh-20100621-16.el6.x86_64.rpm

v mksh-39-7.el6.x86_64.rpm

v ncompress-4.2.4-54.el6_2.1.x86_64.rpm

v rsh-0.17-60.el6.x86_64.rpm

v rsh-server-0.17-60.el6.x86_64.rpm

v rusers-0.17-61.el6.x86_64.rpm

v rusers-server-0.17-61.el6.x86_64.rpm

v rwho-0.17-34.el6.x86_64.rpm

v talk-0.17-34.el6.x86_64.rpm

v talk-server-0.17-34.el6.x86_64.rpm

v tcp_wrappers-7.6-57.el6.x86_64.rpm

v telnet-0.17-47.el6.x86_64.rpm

v telnet-server-0.17-47.el6.x86_64.rpm

v tftp-0.49-7.el6.x86_64.rpm

v xinetd-2.3.14-34.el6.x86_64.rpm

You can download the packages from a site such as pkgs.org or rpm.pbone.net.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Type the following command to verify that an operating system package is

installed:
rpm -qi full_package_name

For example, to verify that authd-1.4.3-30.el6.x86_64 is installed, type rpm
-qi authd-1.4.3-30.el6.x86_64.

Note: You might have to use sudo syntax to run the command successfully.
For example, enter sudo rpm -qi full_package_name.

3. Install any package that is not already installed.
You must download any missing package, and then install the downloaded
package by typing the following command:
rpm -ihv full_package_name.rpm
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For example, to install authd-1.4.3-30.el6.x86_64, type rpm -ihv
authd-1.4.3-30.el6.x86_64.rpm.

4. Repeat these steps on each computer on which you install a Predictive
Customer Intelligence node.

Installing prerequisite operating system packages on the BI
node computer

Specific operating system packages must be installed on the Business Intelligence
(BI) node computer or virtual machine before you install IBM Predictive Customer
Intelligence.

The following packages must be installed:
v libselinux-2.0.94-5.3.el6.i686.rpm

v cracklib-2.8.16-4.el6.i686.rpm

v db4-4.7.25-17.el6.i686.rpm

v audit-libs-2.2-2.el6.i686.rpm

v pam-1.1.1-13.el6.i686.rpm

v apr-util-1.3.9-3.el6_0.1.x86_64

v compat-expat1-1.95.8-8.el6.i686

v openmotif-2.3.3-6.1.el6_4.i686

v compat-expat1.x86_64

Procedure
1. Log on to the BI node computer as the root user or as a user with sudo

permissions.
2. Install the RPM packages.

a. Type the following command to verify that an operating system package is
installed:
rpm -qi full_package_name

For example, to verify that libselinux-2.0.94-5.3.el6.i686 is installed,
type rpm -qi libselinux-2.0.94-5.3.el6.i686.

b. Install any package that is not already installed.
You must download any missing package, and then install the downloaded
package by typing the following command:
rpm -ihv full_package_name.rpm

For example, to install libselinux-2.0.94-5.3.el6.i686, type rpm -ihv
libselinux-2.0.94-5.3.el6.i686.rpm.

Important: To install pam-1.1.1-13.el6.i686.rpm, use the following
command: rpm --force -ivh pam-1.1.1-13.el6.i686.rpm.

Adding each node computer to the hosts file
To ensure that each IBM Predictive Customer Intelligence node computer can
communicate properly, you must add all node computers to the hosts file on each
node computer.

For example, the hosts file on the data node computer must include the Predictive
Analytics node, the Business Intelligence (BI) node, and the Integration Bus node
computers.
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Procedure
1. On each node computer, open the /etc/hosts file.
2. Ensure that each node computer is listed in the file. For example, ensure that

your hosts file contains values such as the following values:
127.0.0.1 localhost.localdomain localhost
##.##.##.## node_server1.domain.com node_server1
##.##.##.## node_server2.domain.com node_server2
##.##.##.## node_server3.domain.com node_server3
##.##.##.## node_server4.domain.com node_server4

3. Save and close the file.

Installing Java on the Predictive Analytics node computer
You must install a Java™ Runtime Environment (JRE) on the computer you use as
the IBM Predictive Customer Intelligence Analytics node.

You must install Java version 1.7 or later on the Analytics node computer.

Installing IBM Data Server Driver on the Integration Bus node
computer

Before you can deploy IBM Predictive Customer Intelligence, you must install the
IBM Data Server Driver for ODBC and CLI on the Integration Bus node computer.

Procedure
1. Go to the IBM driver and client download page (www.ibm.com/support/

docview.wss?uid=swg21385217).
2. Click the link for IBM Data Server Driver for ODBC and CLI (CLI Driver).
3. If prompted, log in with your IBM account.
4. Select IBM Data Server Driver for ODBC and CLI (Linux AMD64 and Intel

EM64T).
5. Click Continue, and download the driver.
6. Go to the directory where you downloaded the driver.
7. Type the following command to extract the files:

tar -zxf ibm_data_server_driver_for_odbc_cli_linuxx64_v10.1.tar.gz

The files are extracted to the odbc_cli/clidriver directory.
8. Copy the odbc_cli directory to the var directory to match the default location

in the server installer. For example, ensure the path is /var/odbc_cli.

Ensuring connectivity between the Analytics node and the data node
computers

In IBM Predictive Customer Intelligence, if the task for configuring the IBM SPSS
Collaboration and Deployment Services displays a database initialization error, you
may have to run the traceroute command to ensure communication between the
Predictive Analytics node and the data node.

Procedure
1. On the Analytics node computer, enter the following command:

traceroute data_node_name

Where data_node_name is the name or IP address of the data node computer.

10 IBM Predictive Customer Intelligence Version 1.0.0: Installation Guide for Linux Operating Systems

http://www.ibm.com/support/docview.wss?uid=swg21385217


2. Try the task again.

Setting ulimit values on nodes where WebSphere Application Server is
to be installed

Before you install IBM Predictive Customer Intelligence, you must ensure that you
have appropriate ulimit values on each node where WebSphere Application Server
is to be installed.

Procedure
1. Log in to the Business Intelligence (BI) node computer as the root user or as a

user with sudo permissions.
a. Go to the /etc/security directory.
b. Open the limits.conf file for editing.
c. Add the following lines to the file:

@root soft nofile 10000
@root hard nofile 16384
* soft nofile 10000
* hard nofile 16384

d. Save and close the file.
e. Restart the computer for the changes to take effect.

2. Log in to the Predictive Analytics node computer as the root user or as a user
with sudo permissions.
a. Go to the /etc/security directory.
b. Open the limits.conf file for editing.
c. Add the following lines to the file:

@root soft nofile 10000
@root hard nofile 16384
* soft nofile 10000
* hard nofile 16384

d. Save and close the file.
e. Restart the computer for the changes to take effect.

Disabling SELinux on all target computers
You must disable the Security-Enhanced Linux (SELinux) feature on all computers
where you install an IBM Predictive Customer Intelligence node.

SELinux can be re-enabled after the installation is complete.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Type getenforce and press Enter. The resulting message should say Disabled.
3. If the status is not Disabled, do the following.

a. Go to the /etc/sysconfig directory.
b. Open the selinux file for editing.
c. Change the SELINUX value to disabled.

For example:
SELINUX=disabled

d. Save and close the file.
e. Restart the computer for the changes to take effect.
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4. Repeat these steps on each computer on which you install a Predictive
Customer Intelligence node.

Computer firewall settings required for the installation
The Deployment Wizard requires bidirectional communication with each IBM
Predictive Customer Intelligence node when you install a server component or
server artifact component, and your firewall can interfere with this communication.

To ensure this bidirectional communication, you must configure your firewall
settings for the installation. Alternatively, you can temporarily disable your firewall
during the installation.

Text files that contain the commands you can use to open the ports that are used
by IBM Predictive Customer Intelligence are provided with the installation. The
Initial-firewall-settings.txt file contains the port information that you must
set before you run the installation. The Initial-firewall-settings.txt file
contains the port information that you must set after the installation is complete.
The files are available in the disk1 directory.

Configuring your firewall settings for the Deployment Wizard
On each computer on which you install an IBM Predictive Customer Intelligence
node, you must open two ports to allow the bidirectional communication that is
required by the Deployment Wizard. After you open the ports in your firewall,
you can then enter these port values in the Deployment Wizard.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the two ports that are required by the Deployment Wizard with
the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 35000 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 30000 -j ACCEPT

where port 35000 and 30000 are available port numbers on your computers.
You do not have to use these port numbers, but you must use available port
numbers.
If you do not use ports 35000 and 30000, ensure that you change only the port
number values in the commands.

Tip: For consistency, use the same port numbers for each target computer.
4. Type the following command to save your firewall settings:

/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added port should appear in the list.
7. Repeat these steps on each computer on which you install a Predictive

Customer Intelligence node, and on the computer from where you run the
installation if it is not one of the node computers.

12 IBM Predictive Customer Intelligence Version 1.0.0: Installation Guide for Linux Operating Systems



Configuring your firewall settings for the data node
installation and configuration

Before you install and configure the IBM Predictive Customer Intelligence data
node, you must ensure that the database server port number is open on the data
node computer.

Procedure
1. Log in to the data node computer as the rootuser or as a user with sudo

permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the port with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port -j ACCEPT

For example, to open 50000, the default port number for IBM DB2, type the
following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 50000 -j ACCEPT

Note: If you use a port number other than 50000 for your database server,
ensure that you open the appropriate port number.

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for all nodes
On each computer on which you install an IBM Predictive Customer Intelligence
node, you must open specific ports.

The following ports must be open:
v vnc-server
v x11
v 5901
v 5902
v 5903
v 6001
v 6002
v 6003
v 22

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
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iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port -j ACCEPT

For example, to open vnc-server, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport vnc-server -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added port should appear in the list.
7. Repeat these steps on each computer on which you install a Predictive

Customer Intelligence node.

Disabling your computer's firewall during the installation
If you choose to temporarily disable your computer's firewall during the
installation of IBM Predictive Customer Intelligence, ensure that you enable the
firewall on each node after the installation is complete.

Important: If you disable your computer's firewall during the installation, you
must still ensure that the required ports are opened on each node computer when
you restart your firewall.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Type the following command:

/etc/init.d/iptables stop

3. Repeat these steps on each computer on which you install a node and on the
server from which you are running the installation.

What to do next

After the installation is complete, on each node, type /etc/init.d/iptables start
to restart your firewall.

Mounting the USB hard disk drive
The installation files for IBM Predictive Customer Intelligence are provided on a
universal serial bus (USB) hard disk drive. You can run the installation from the
USB or you can copy the files to your computer before you start the installation.
Before you do either, you must mount the USB hard disk drive.

For more information about mounting USB hard disk drives, see the Red Hat
Customer Portal (https://access.redhat.com/home).
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Chapter 3. Installation of the server components

The installation program installs the required software on each computer that you
identify as an IBM Predictive Customer Intelligence node. The installation program
can be run from one of the computers that will be a node, or it can be run from
another computer.

Installation process
With the IBM Predictive Customer Intelligence installation program, you can select
the individual computers on which each solution node is to be installed and enter
configuration information for each software component.

In the diagram, the staging server represents the computer from which you run the
installation. In your installation, the staging server can also be used as a node
computer. If you use a separate computer as the staging server, that computer
must also use the same operating system as the other computers on which you
install a node. It must also have the same prerequisites.

Starting the Launchpad for the server components
Use the Launchpad to start the IBM Predictive Customer Intelligence installation.

Before you begin

Ensure that you are logged in as root or a user with sudo permissions.

You must have a Firefox web browser that is installed and set as your default web
browser on the computer from where you run the IBM Predictive Customer
Intelligence installation. Firefox must be version 17 as a minimum and version 20
at the latest.

Figure 2. IBM Predictive Customer Intelligence installation process
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Procedure
1. Go to the directory where you downloaded the installation files.
2. Decompress the installation files. For example, in a terminal window enter tar

-xvf filename.tar.gz or sudo tar -xvf filename.tar.gz.
3. Go to the disk1 directory where you decompressed the files.
4. If you are installing as a user with sudo permissions, enter the following

command to ensure that the Launchpad and Deployment Wizard open
correctly:
export DISPLAY=ipaddress:vncdisplay

where ipaddress is the IP address of the computer where you are running the
installation, and vncdisplay is the VNC display ID for the user who is running
the installation. For example, enter export DISPLAY=127.0.0.1:2

5. If you are installing as a user with sudo permissions, enter the following
command:
xhost +

6. Enter the following command:
./launchpad.sh

Important: Do not enter sudo in front of the command.
7. Review the information in the Launchpad panels.

Selecting the installation type
You can choose a default installation or you can choose to distribute the Analytics
node components.

A Default Environment installation installs IBM Predictive Customer Intelligence
onto four node computers. A Distributed Environment (Analytics Node only) lets
you add Analytics node components on additional node computers.

You can only use a Distributed Environment (Analytics Node only) installation
after you have completed a Default Environment installation. You must run a
Distributed Environment (Analytics Node only) installation for each additional
Analytics node component you want to add to your environment.

Procedure
1. Select one of the following options:

v Default Environment

If you are installing IBM Predictive Customer Intelligence for the first time,
you must select Default Environment.
After you have completed a Default Environment installation, you can select
a Distributed Environment (Analytics Node only) installation.

v Distributed Environment (Analytics Node only)

See Chapter 4, “Distribute Analytics node components,” on page 35 for more
information.

2. Click Next.

Validating your target computers
Use the Launchpad to validate that your IBM Predictive Customer Intelligence
target computers have all of the prerequisite libraries installed.

16 IBM Predictive Customer Intelligence Version 1.0.0: Installation Guide for Linux Operating Systems



If you are using a Distributed Environment (Analytics Node only) installation,
you are prompted only for the additional Analytics node computers you are
adding to the environment.

Before you begin

You must have sshpass-1.05-1.el6.i686.rpm installed on each node computer to
be able to validate the target computers. You can download sshpass-1.05-
1.el6.i686.rpm from a site such as pkgs.org or rpm.pbone.net.

Procedure
1. In the Launchpad, click Next until the Validate the Data Node Computer page.
2. Enter the server name of IP address of the data node computer in the

Computer Name box.
a. Enter a user name and password for a user on the target computer in the

User Name and Password boxes.
b. Click Validate Node.
c. If there are any missing prerequisites, use the CheckLib_output.txt file to

help you install or configure the prerequisites, and try the validation again.
The CheckLib_output.txt is in the /var/PCITemp directory.

d. If the validation succeeds, click Next.
3. Repeat the step for each node computer.

Starting the Deployment Wizard for the server components
Use the Launchpad to start the IBM Predictive Customer Intelligence server
Deployment Wizard.

Procedure
1. In the Launchpad, on the Install and Configure page, click one of the

following options:
a. If you are installing as a user with sudo permissions, select Start the

Deployment Wizard as a Sudo User.
v In the Computer Name box, enter the name or IP address of the

computer on which you are running the Deployment Wizard.
v In the VNC Display ID box, enter the display for the user. For example,

enter 1 or 2.
b. If you are installing as root, select Start the Deployment Wizard as the

Root User.
2. Click Start Deployment Wizard.

Setting ports for the Deployment Wizard to use
If you install IBM Predictive Customer Intelligence components while your Linux
iptables run, you must set the ports that you opened in the Deployment Wizard.

Procedure
1. In the Deployment Wizard, click Edit > Preferences.

The Deployment Preferences window appears.
2. Enter 30000 in the Data Port Number box.
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Important: Ensure that you enter the port number that you opened if you
selected a port other than 30000.

3. Enter 35000 in the Communication Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 35000.

4. If you use the computer on which you run the installation as a node, do the
following steps:
a. Click Target Computer Settings.
b. Select localhost in the Target Computer field.
c. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.

Note: The RMI Registry Port is unavailable if you use localhost as a node.

Specifying the target computers to install the server components
You must specify a different target computer for each IBM Predictive Customer
Intelligence node. A node can be installed on a computer or virtual machine, but
each node must be installed on a separate computer or virtual machine.

Before you begin

You must have root access on each computer on which you install a node.

You might have to change a setting in a configuration file on your target computer
to allow the Deployment Wizard to access the computer as root. Use the
following steps if you receive a message that says the connection to the target
computer was refused:
1. On the target computer, go to the /etc/ssh directory and open sshd_config for

editing.
2. Change the PermitRootLogin property to yes.
3. Save the file, and restart the server for the change to take effect.

Procedure
1. On the Specify Target Computers pages of the Deployment Wizard, enter the

name or IP address of the computer on which you install a node in the Target
Computer box.
The Deployment Wizard prompts you for each node computer.
If you install a node on the computer where you run the Deployment Wizard,
you can enter localhost.

2. Click Add.
When you enter a computer other than localhost, in the Target Computer
Credentials box, do the following steps:
a. Enter the User ID and Password for the root user or a user with sudo

permissions.

Important: Ensure that you enter the credentials for the root user or a user
with sudo permissions on the target computer.

b. Click Test Login.
c. Click Add.
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The computer that you entered appears in the Selected target computers
box.

3. Do the following steps if you install while your Linux iptables run.
a. Click Edit > Preferences.
b. Click Target Computer Settings.
c. Select the computer name or IP address in the Target Computer field.
d. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.
e. Enter the Data Port Number that you set in the RMI Registry Port field.

For example, enter 30000.

Note: If you use localhost as a node in the installation, the RMI Registry
Port is unavailable.

4. In the Selected target computers box, select the target computer, and click Test
Connections.

Important: Test Connections tests the connection, tests the credentials, and
locates or enables a deployment agent on the target computer. You must have
an active deployment agent on each target computer.
If you receive an error message after you click Test Connections, you might
have to change some settings on your computers.
v Edit your iptable settings or temporarily disable your firewall. For more

information, see “Computer firewall settings required for the installation” on
page 12.

v Compare and correct your domain name system (DNS) settings for each
computer. For example, type sudo system-config-network. Select DNS
configuration, and ensure that your host name domain and DNS search path
settings are correct.

v Ensure that the /etc/hosts file has the correct entries. For an example, see
“Test Connections validation errors” on page 70.

5. Click Next.
6. Repeat the steps for each computer on which you install a node.

Configuring parameters for the server components installation
The Deployment Wizard displays some default values for each component of IBM
Predictive Customer Intelligence. You can accept the default values or change them
to suit your environment.

If you are prompted for users, the Deployment Wizard creates the users on the
appropriate target node computer, if they do not exist. For example, IBM DB2
requires a DB2 administrator user, an instance owner user, and a fenced user. Each
of these users is created on the data node computer.

Procedure

Enter values in each field on each page of the Deployment Wizard:
v Click Browse to browse the target computer's file system. It does not browse the

local computer from where you run the Deployment Wizard.
v For some values, such as passwords, default values are not provided. Ensure

that you enter all values on each page of the Deployment Wizard.
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v On the Configure IBM DB2 Enterprise Edition page, enter a name for each
database that is to be created by the Deployment Wizard.

Important: You cannot use the same user for the IBM DB2 administrative user
and the instance owner. They must be different users.

Table 1 includes the configuration parameters for IBM DB2.

Table 1. IBM DB2 configuration parameters for a new database server installation

Field Default or example value Description

DB2 Server Installation
Directory

/opt/ibm/db2/V10.1 The location where IBM DB2
is to be installed on the data
node computer.

DB2 Database Port Number 50000 The port number that is used
by IBM DB2.

DB2 Server Administrative
User Name

dasusr1 The user ID that runs the
administration server.

DB2 Server Administrative
Password

There is no default value for
this field.

The password for the user ID
that runs the administration
server.

The password cannot contain
more than 8 characters.

DB2 Server Administrative
Home Directory

/home/dasusr1 The home directory for the
user ID that runs the
administration server. This
directory is on the data node
computer's file system.

DB2 Instance Owner User
Name

db2inst1 The user ID that controls the
DB2 processes and owns the
directories that are used by
the database instance.

DB2 Instance Owner
Password

There is no default value for
this field.

The password for the DB2
instance owner user.

The password cannot contain
more than 8 characters.

DB2 Instance Owner Home
Directory

/home/db2inst1 The home directory for the
DB2 instance owner user.
This directory is on the data
node computer's file system.

DB2 Fenced User Name db2fenc1 The user ID that can run
user-defined functions and
store procedures.

DB2 Fenced Password There is no default value for
this field.

The password for the DB2
instance owner user.

The password cannot contain
more than 8 characters.

DB2 Fenced User Home
Directory

/home/db2fenc1 The home directory for the
DB2 instance owner user.
This directory is on the data
node computer's file system.

Table 2 on page 21 includes the database names that are created.
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Table 2. IBM DB2 configuration parameters: Database names

Field Default or example value Description

SPSS Database Name SPSSDB The SPSS database that is
used by the components that
are installed on the
Predictive Analytics node
computer.

Cognos Database Name COG102CS The IBM Cognos content
store database.

Table 3 includes the configuration parameters for the IBM DB2 client.

Note: The values apply to all nodes where the IBM DB2 client is installed.

Table 3. IBM DB2 client parameters

Field Default or example value Description

DB2 Client Installation
Directory

/opt/ibm/db2/V10.1 The location where the IBM
DB2 client is to be installed.
This directory is on the
Business Intelligence (BI)
node and Analytics node
computer's file system.

DB2 Client Instance User
Name

db2inst1 The user ID for the DB2
client.

DB2 Client Instance
Password

There is no default value for
this field.

The password for the DB2
client instance owner user.

DB2 Client Instance Home
Directory

/home/db2inst1 The home directory for the
DB2 client instance owner
user on each node.

Table 4 includes the configuration parameters for WebSphere Application Server.

Table 4. WebSphere Application Server installation parameters

Field Default or example value Description

WebSphere Installation
Directory

/opt/IBM/WebSphere/
AppServer

The location where the
WebSphere Application
Server is to be installed. The
location is the same for each
node where WebSphere is
installed.

Table 5 includes the configuration parameters for IBM HTTP Server.

Table 5. IBM HTTP Server installation parameters

Field Default or example value Description

HTTP Server Installation
Directory

/opt/IBM/HTTPServer The location where IBM
HTTP Server is to be
installed. This directory is on
the BI node computer's file
system.

HTTP Port Number 80 The port number that is used
by HTTP Server.
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Table 5. IBM HTTP Server installation parameters (continued)

Field Default or example value Description

IBM Installation Manager
Installation Directory

/opt/IBM/
InstallationManager/
eclipse/tools/imcl

The location where IBM
Installation Manager is to be
installed. This directory is on
the BI node computer's file
system.

Table 6 includes the installation location for IBM Cognos Business Intelligence.

Table 6. IBM Cognos BI installation parameters

Field Default or example value Description

Cognos BI Installation
Location

/opt/ibm/cognos/c10_64 The location where IBM
Cognos BI is to be installed.
This directory is on the BI
node computer's file system.

Table 7 includes the configuration parameters for the WebSphere Application
Server profile that is used for IBM Cognos Business Intelligence.

Table 7. WebSphere Application Server profile for IBM Cognos BI parameters

Field Default or example value Description

WebSphere Application
Server Profile Directory

/opt/IBM/WebSphere/
AppServer/profiles

The location where the
WebSphere profile is to be
created. This directory is on
the BI node computer's file
system.

WebSphere Application
Server Cognos Profile Name

COGNOSProfile The name of the WebSphere
profile that is used for IBM
Cognos BI.

Cognos Business
Intelligence Server Host
Name

This value is automatically
entered.

The name or IP address of
the BI node computer.

WebSphere Application
Server Profile Template
Directory

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located.

Table 8 includes the configuration parameters for IBM Cognos Business
Intelligence.

Table 8. IBM Cognos BI Server parameters

Field Default or example value Description

Database Host Name This value is automatically
entered.

The name or IP address of
the data node computer.

IBM WebSphere
Application Server BI Node
Host Name

This value is automatically
entered.

The name or IP address of
the BI node.

Cognos Dispatcher
Application Server Port

9080 The HTTP transport port
number for the WebSphere
Application Server where
IBM Cognos is running.

Database Server Host Name This value is automatically
entered.

The name or IP address of
the data node.
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Table 8. IBM Cognos BI Server parameters (continued)

Field Default or example value Description

IBM Cognos Mobile Server
Installation Directory

/opt/IBM/PCI/Server/
CognosMobile

The location where the IBM
Cognos Mobile installation
files are copied.

To use IBM Cognos Mobile,
you must install the product
manually.

Cognos Real Time
Monitoring Installable
Directory

/opt/IBM/PCI/Server/
CognosRTM

The location where the IBM
Cognos Real-time Monitoring
installation files are copied.

To use IBM Cognos
Real-time Monitoring, you
must install the product
manually.

Table 9 includes the configuration parameters for IBM Integration Bus.

Table 9. IBM Integration Bus installation parameters

Field Default or example value Description

WebSphere Message Broker
Installation Location

/opt/ibm/mqsi/9.0.0.1 The location where IBM
Integration Bus is to be
installed. This directory is on
the Integration Bus node
computer's file system.

IBM Integration Bus was
previously named
WebSphere Message Broker.

WMB ODBC Database
Extender Install Location

/opt/ibm/IE02/2.0.1 The location where IBM
Integration Bus ODBC
Database Extender is to be
installed. This directory is on
the Integration Bus node
computer's file system.

WebSphere Message Broker
Explorer Installation
Directory

/opt/IBM/IBExplorer The location where IBM
Integration Explorer is to be
installed. This directory is on
the Integration Bus node
computer's file system.

IBM Integration Explorer
was previously named
WebSphere Message Broker.

Table 10. IBM SPSS Collaboration and Deployment Server parameters

Field Default or example value Description

SPSS Collaboration and
Deployment Services Server
Installation Directory

/opt/IBM/SPSS/Deployment/
6.0/Server

The location where IBM SPSS
Collaboration and
Deployment Services is to be
installed. This location is on
the Analytics node
computer's file system.
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Table 10. IBM SPSS Collaboration and Deployment Server parameters (continued)

Field Default or example value Description

IBM Installation Manager
Installation Directory

/opt/IBM/
InstallationManager/
eclipse/tools/imcl

The location where IBM
Installation Manager is to be
installed. This directory is on
the Analytics node
computer's file system.

WebSphere Profile Location /opt/IBM/WebSphere/
AppServer/profiles

The location where the
WebSphere profile is to be
created. This directory is on
the Analytics node
computer's file system.

WebSphere Profile Default
Template Location

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located. This directory is
on the Analytics node
computer's file system.

WebSphere Host Name This value is automatically
entered.

The name or IP address of
the Analytics node computer.

SPSS DB2 Database Host
Name

This value is automatically
entered.

The name or IP address of
the data node computer.

SPSS Collaboration and
Deployment Service Server
Administrative User Name

admin The IBM SPSS Collaboration
and Deployment Services
administrative user.

SPSS Collaboration and
Deployment Service Server
Administrative Password

There is no default value for
this field.

The password for the IBM
SPSS Collaboration and
Deployment Services
administrative user.

SPSS Modeler Server
Installation Directory

/usr/IBM/SPSS/
ModelerServer/16.0

The directory where the IBM
SPSS Modeler Server is to be
installed. This directory is on
the Analytics node computer.

SPSS Data Access Pack
Installation Directory

/root/SDAP71 The directory where the IBM
SPSS Data Access Pack is to
be installed. This directory is
on the Analytics node
computer.

SPSS Statistics Server
Installation Directory

/opt/IBM/SPSS/
StatisticsServer22

The directory where the IBM
SPSS Statistics Server is to be
installed. This directory is on
the Analytics node computer.

SPSS Modeler Premium
Solution Publisher
Installation Directory

/opt/IBM/SPSS/
ModelerSolutionPublisher/
16.0

The directory where the IBM
SPSS Modeler Premium
Solution Publisher is to be
installed. This directory is on
the Analytics node computer.

SPSS Modeler Solution
Publisher Installation
Directory

/opt/IBM/SPSS/
ModelerSolutionPublisher/
16.0

The directory where the IBM
SPSS Modeler Solution
Publisher is to be installed.
This directory is on the
Analytics node computer.
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Starting the installation
After you enter all of the required fields in the Deployment Wizard, you can start
the installation and configuration of the IBM Predictive Customer Intelligence
components.

Procedure

On the Summary Panel of the Deployment Wizard, click Deploy all.
If you choose to deploy the tasks individually, you must click Deploy task for each
task in the order that the tasks appear on the Summary panel.

Note: The time to deploy the software is estimated by the Deployment Wizard.
The actual time required depends on a variety of factors, such as network speed.
In most cases, the deployments will take significantly less time than what is
initially displayed by the Deployment Wizard.

Optional installation of more IBM Cognos components
IBM Cognos Mobile and IBM Cognos Real-time Monitoring installation files are
provided with your installation of IBM Predictive Customer Intelligence. You can
optionally install these server components to extend your solution capabilities.

The installation files for these products are available in the /opt/IBM/PCI/Server
directory on the Business Intelligence (BI) node computer.

For information about installing these products, see their respective documentation.

Configure the server components and test the installation
After the installation of the IBM Predictive Customer Intelligence server
components is complete, you must perform some additional configuration tasks
and then test the installation.

Testing the database installation and configuration
You can test the database installation and configuration by logging in to the IBM
Predictive Customer Intelligence data node computer and listing the databases on
the server. You can also list the databases available on each node computer where
the IBM DB2 client was installed.

Procedure

Log on to the data node computer.
1. Open a terminal window, and change to the database instance owner user. For

example, su - db2inst1.
2. Enter the following command to list the databases on the computer:

db2 list database directory

The following databases are listed:
v COG102DB

v SPSSDB
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Configuring WebSphere Application Server for IBM Cognos BI
To complete the installation of the IBM Predictive Customer Intelligence server
components, you must configure properties in IBM WebSphere Application Server
for IBM Cognos Business Intelligence.

Procedure
1. Open a web browser.
2. In the address bar, type the address for the WebSphere Admin Console that

was installed on the BI node computer.
The Admin console address is: http://bi_node_name:9060/ibm/console where
bi_node_name is the name or IP address for the BI node computer.

3. Leave the User ID box empty, and click Log in.
4. Expand Servers > Server Types > WebSphere application servers, and click

server1.
5. Under Server Infrastructure, expand Java and Process Management, and click

Process Definition.
6. Under Additional Properties, click Environment Entries.
7. Click LD_LIBRARY_PATH.
8. In the Value box, add the following value to the path:

:/opt/ibm/db2/V10.1/lib32/

This path points to the IBM DB2 32-bit library file libdb2.so.

Important: If you did not use the default installation locations, ensure you use
the paths that you entered.
For example, the Value box, should include the following path:
/opt/ibm/cognos/c10_64/bin64/:/opt/ibm/db2/V10.1/lib32/

9. Click Apply, and then click Save.

Saving your IBM Cognos Configuration settings
You must save the configuration settings in IBM Cognos Configuration before you
can start the IBM Cognos application in WebSphere Application Server for IBM
Predictive Customer Intelligence.

Procedure
1. Log in to the BI node computer as root.
2. Enter the following command to load the profile that is needed for IBM Cognos

BI, and press Enter:
. ~/.bash_profile

The .bash_profile file contains the environment variables that are needed to
start IBM Cognos Configuration.

3. Go to the /opt/ibm/cognos/c10_64/bin64 directory.
4. Type the following command:

./cogconfig.sh

IBM Cognos Configuration starts.
5. Click File > Save.
6. Close IBM Cognos Configuration.

Important: If you are prompted to start the Cognos Content Database service,
click No.

26 IBM Predictive Customer Intelligence Version 1.0.0: Installation Guide for Linux Operating Systems



7. Click File > Exit.

Starting the services on the BI node computer
For IBM Predictive Customer Intelligence, start the IBM Cognos BI services by
starting the WebSphere Application Server profile. You must also start IBM HTTP
Server.

The WebSphere Application Server profile is automatically started by the
installation. You must restart the profile after you save the IBM Cognos
configurations settings. Restarting the profile starts the IBM Cognos BI services.

Procedure
1. Log in to the BI node computer as the root user.
2. Go to the WebSphere Application Server Profile Location. For example, go to

the /opt/IBM/WebSphere/AppServer/profiles/COGNOSProfile/bin directory if
you used the default path in the Deployment Wizard.

3. Type ./stopServer.sh server1 to stop WebSphere Application Server.
4. Type ./startServer.sh server1 to start WebSphere Application Server.

It can take several minutes for all of the IBM Cognos services to start for the
first time.

Setting the password for the mqm user on the Integration Bus
node computer

You must set the password for the mqm user on the Integration Bus node computer
for IBM Predictive Customer Intelligence.

Procedure
1. Log in to the Integration Bus node computer as the root user or as a user with

sudo permissions.
2. Type the following command:

passwd mqm

3. Enter mqm and the new password.
You do not have to use mqm. It is only a suggestion. If you do use mqm, you will
see a message saying that your password is too weak. But, you can ignore the
message.

Configure the Integration Bus node components
To configure the Integration Bus node components, you must create a broker, a
queue manager, and an execution group. You must also set authorizations for the
user that runs the broker and queue manager. Authorization is required when the
client is running on a different computer than the server components.

Creating a broker and queue manager
You create a broker for IBM Predictive Customer Intelligence from the command
line. A queue manager is automatically created when you create the broker.

You must assign a user for the broker and queue manager. The user must be a
local administrator user.

Some additional settings might be required to configure WebSphere MQ. For more
information, see the WebSphere MQ documentation (www.ibm.com/support/
knowledgecenter/SSFKSJ_7.5.0/com.ibm.mq.ins.doc/q008520_.htm?lang=en).
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Procedure
1. In a terminal window, go to the installation_location/mqsi/9.0.0.1/bin

directory. For example, if you installed to the default location, go to the
/opt/ibm/mqsi/9.0.0.1/bin directory.

2. Change to the mqm user. For example, su mqm.
3. Enter the following command to load the profile that is needed for the mqm

user, and press Enter:
. ~/.bash_profile

4. Enter the following command to create and start the broker and queue
manager:
mqsicreatebroker broker_name -q queue_manager_name

For example, to create a broker that is named pcibroker and a queue manager
that is named pciqmgr, enter:
mqsicreatebroker pcibroker -q pciqmgr

5. Enter the following command to start the broker:
mqsistart broker_name

For example, to start a broker that is named pcibroker, enter:
mqsistart pcibroker

6. Enter the following command to create an execution group:
mqsicreateexecutiongroup broker_name -e executiongroupname

For example, to create an execution group that is named pciegroup, enter:
mqsicreateexecutiongroup pcibroker -e pciegroup

Enabling remote access for the queue manager
For IBM Predictive Customer Intelligence, you must start the queue manager
command line processor to enable remote access to the queue manager.

Procedure
1. As the mqm user, enter the following command to start the queue manager:

runmqsc queue_manager_name

For example, if your queue manager is named pciqmgr, enter:
runmqsc pciqmgr

2. Enter the following lines, and press Enter after each line:
START LISTENER

ALTER QMGR CHLAUTH(ENABLED)

SET CHLAUTH(SYSTEM.BKR.CONFIG) TYPE(ADDRESSMAP) ADDRESS('*')
MCAUSER('mqm')

SET CHLAUTH(SYSTEM.BKR.CONFIG) TYPE(BLOCKUSER) USERLIST('*NOACCESS')

END

Important: The ADDRESS(’*’) value in the command allows connections from
any IP address. Consider restricting the access to a single computer. For more
information about these values, see the WebSphere MQ documentation.

3. If you want to use a specific port number for the listener, enter the following
command:
runmqlsr -t tcp -m queue_manager_name -p port_number

Ensure that you open the listener port number. If you did not specify a port
number, the default port number is 1414 for the first broker you create.
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Testing the installation of the server components
You can test the installation of the IBM Predictive Customer Intelligence server
components by accessing some of the component portals.

For example, you can open the IBM Cognos BI portal on the BI node. If the portal
opens, IBM Cognos BI is installed and running. You can also access the SPSS
configuration tool on the Analytics node computer.

Procedure
1. Open a web browser.
2. In the address bar, type the address for the IBM Cognos Content Manager

status page.
The address is http://bi_node_name:9080/p2pd/servlet, where bi_node_name is
the name or IP address for the BI node computer.
The Content Manager status says Running.

3. In the address bar, type the address for the IBM Cognos BI portal.
The address is http://bi_node_name/ibmcognos/, where bi_node_name is the
name or IP address for the BI node computer.

Note: Ensure that you add the trailing / to the URL.
IBM Cognos Connection appears.

4. In the address bar, type the address for the SPSS administration console.
The address is http://analytics_node_name:9080/config, where
analytics_node_name is the name or IP address for the Analytics node
computer.
The SPSS administration console appears.

Computer firewall settings to run the server components
Each IBM Predictive Customer Intelligence node computer requires certain ports to
be opened for the server components to operate in a multi-computer solution, and
you must configure your firewall settings for each specific node.

Text files that contain the commands you can use to open the ports that are used
by IBM Predictive Customer Intelligence are provided with the installation. The
Initial-firewall-settings.txt file contains the port information that you must
set before you run the installation. The Initial-firewall-settings.txt file
contains the port information that you must set after the installation is complete.
The files are available in the disk1 directory.

Configuring your firewall settings for the Analytics node
computer

You must ensure that certain ports are open on the Predictive Analytics node
computer for IBM Predictive Customer Intelligence.

The following ports must be open:
v 45088
v 58313
v 28053
v tungsten-https
v glrpc
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v corbaloc
v 59356
v 9043
v 9060

Procedure
1. Log in to the Analytics node computer as the root user or as a user with sudo

permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port -j ACCEPT

For example, to open 45088, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 45088 -j ACCEPT

4. Repeat the previous step for each of the required port values.
5. Type the following command to save your firewall settings:

/etc/init.d/iptables save

6. Type the following command to restart your firewall.
/etc/init.d/iptables restart

7. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the BI node computer
You must ensure that certain ports are open on the Business Intelligence (BI) node
computer for IBM Predictive Customer Intelligence.

The following ports must be open:
v 9362
v vrace
v 9663
v corbaloc
v 9043
v glrpc
v http
v tungsten-https
v 9060

Procedure
1. Log in to the BI node computer as the root user or as a user with sudo

permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port -j ACCEPT

For example, to open 9362, type the following command
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iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9362 -j ACCEPT

4. Repeat the previous step for each of the required port values.
5. Type the following command to save your firewall settings:

/etc/init.d/iptables save

6. Type the following command to restart your firewall.
/etc/init.d/iptables restart

7. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the Integration Bus node
computer

You must ensure that certain ports are open on the Integration Bus node computer
for IBM Predictive Customer Intelligence.

The following ports must be open:
v boks
v boks_clntd
v boks_servm
v boks_servc
v ibm-mqseries

Procedure
1. Log in to the Integration Bus node computer as the root user or as a user with

sudo permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port -j ACCEPT

For example, to open boks, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport boks -j ACCEPT

4. Repeat the previous step for each of the required port values.
5. Type the following command to save your firewall settings:

/etc/init.d/iptables save

6. Type the following command to restart your firewall.
/etc/init.d/iptables restart

7. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the data node computer
You must ensure that certain ports are open on the data node computer for IBM
Predictive Customer Intelligence.

The following ports must be open:
v ibm-db2
v db2c_db2inst1
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Procedure
1. Log in to the data node computer as the root user or as a user with sudo

permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port -j ACCEPT

For example, to open ibm-db2, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport ibm-db2 -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring NFS mount settings for the Integration Bus node and
Analytics node computers

You must configure network file system (NFS) mounts on the Integration Bus node
and the Predictive Analytics node computers to allow file transfers between these
nodes.

Procedure
1. Log in to the computer as the root user.

Note: You must perform these steps on both the Integration Bus node and
Analytics node computers.

2. Go to the /etc/sysconfig directory, and open the nfs file in a text editor.
3. Add the following lines to the file or uncomment the lines if they already exist

in the file:
RQUOTAD_PORT=875
LOCKD_TCPPORT=32803
LOCKD_UDPPORT=32769
MOUNTD_PORT=892
STATD_PORT=662
STATD_OUTGOING_PORT=2020

4. Save and close the file.
5. Enter the following commands to restart the Linux services. Press Enter after

each command.
service portmap restart
service nfs restart
service rpcsvcgssd restart

6. Open the iptables file in a text editor.
7. Add the following lines to the file before the final LOG and DROP lines in the

RH-Firewall-1-INPUT chain.
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state
NEW -p udp -dport 111 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 111 -j ACCEPT
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-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 2049 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 32803 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p udp
-dport 32769 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 892 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p udp
-dport 892 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 875 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p udp
-dport 875 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 662 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p udp
-dport 662 -j ACCEPT

8. Save and close the file.
9. Enter the following command to restart the iptables.

service iptables restart
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Chapter 4. Distribute Analytics node components

After you complete a default environment installation, you can optionally add
Analytics node components. Adding Analytics node components can improve the
performance of the solution.

You must run a new distributed environment installation for each Analytics node
component that you want to add to your environment.

Creating a database for an additional Collaboration and Deployment
Services instance

You must create a database for each instance of SPSS Collaboration and
Deployment Services Server you add to your environment using a Distributed
Environment (Analytics Node only) installation.

Each instance of SPSS Collaboration and Deployment Services Server requires its
own database. You cannot use the same database for multiple instances of SPSS
Collaboration and Deployment Services Server.

Procedure
1. Go to the directory where you downloaded the installation files, and go to the

IBMPCI_Distributed\disk1 directory.
2. Copy the script that is named pci-spssdbcreation.sh to the data node

computer.
3. Log on to the data node computer as root user.
4. Run the following command to create the database.

./pci-spssdbcreation.sh database_name database_instance

Where database_name is the name of the database you want to create for the
new instance of SPSS Collaboration and Deployment Services and
database_instance is the database instance in which you are creating the
database.
For example,
./pci-spssdbcreation.sh SPSSDB1 db2inst1

Starting the Launchpad for the Distributed Environment installation
Use the Launchpad to start the IBM Predictive Customer Intelligence installation.

Before you begin

Ensure that you are logged in as root or a user with sudo permissions.

You must have a Firefox web browser that is installed and set as your default web
browser on the computer from where you run the IBM Predictive Customer
Intelligence installation. Firefox must be version 17 as a minimum and version 20
at the latest.
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Procedure
1. Ensure that you include each new Analytics node computer in the hosts file on

the computer from where you are running the installation and the data node
computer. Also, ensure that the hosts file on each new Analytics node
computer includes the data node computer.
For more information, see “Adding each node computer to the hosts file” on
page 9.

2. Go to the directory where you decompressed the installation files.
3. Go to the disk1 directory where you decompressed the files.
4. If you are installing as a user with sudo permissions, enter the following

command to ensure that the Launchpad and Deployment Wizard open
correctly:
export DISPLAY=ipaddress:vncdisplay

where ipaddress is the IP address of the computer where you are running the
installation, and vncdisplay is the VNC display ID for the user who is running
the installation. For example, enter export DISPLAY=127.0.0.1:2

5. If you are installing as a user with sudo permissions, enter the following
command:
xhost +

6. Enter the following command:
./launchpad.sh

Important: Do not enter sudo in front of the command.
7. Review the information in the Launchpad panels.

Selecting the installation type for a distributed installation
Choose a Distributed Environment (Analytics Node only) installation to add
Analytics node components to your environment.

You can only use a Distributed Environment (Analytics Node only) installation
after you have completed a Default Environment installation. You must run a
Distributed Environment (Analytics Node only) installation for each additional
Analytics node component you want to add to your environment.

Procedure
1. Select Distributed Environment (Analytics Node only).
2. Click Next.

Validating your target computers
Use the Launchpad to validate that your IBM Predictive Customer Intelligence
target computers have all of the prerequisite libraries installed.

If you are using a Distributed Environment (Analytics Node only) installation,
you are prompted only for the additional Analytics node computers you are
adding to the environment.

Before you begin

You must have sshpass-1.05-1.el6.i686.rpm installed on each node computer to
be able to validate the target computers. You can download sshpass-1.05-
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1.el6.i686.rpm from a site such as pkgs.org or rpm.pbone.net.

Procedure
1. In the Launchpad, click Next until the Validate the Data Node Computer page.
2. Enter the server name of IP address of the data node computer in the

Computer Name box.
a. Enter a user name and password for a user on the target computer in the

User Name and Password boxes.
b. Click Validate Node.
c. If there are any missing prerequisites, use the CheckLib_output.txt file to

help you install or configure the prerequisites, and try the validation again.
The CheckLib_output.txt is in the /var/PCITemp directory.

d. If the validation succeeds, click Next.
3. Repeat the step for each node computer.

Starting the Deployment Wizard for the server components
Use the Launchpad to start the IBM Predictive Customer Intelligence server
Deployment Wizard.

Procedure
1. In the Launchpad, on the Install and Configure page, click one of the

following options:
a. If you are installing as a user with sudo permissions, select Start the

Deployment Wizard as a Sudo User.
v In the Computer Name box, enter the name or IP address of the

computer on which you are running the Deployment Wizard.
v In the VNC Display ID box, enter the display for the user. For example,

enter 1 or 2.
b. If you are installing as root, select Start the Deployment Wizard as the

Root User.
2. Click Start Deployment Wizard.

Setting ports for the Deployment Wizard to use
If you install IBM Predictive Customer Intelligence components while your Linux
iptables run, you must set the ports that you opened in the Deployment Wizard.

Procedure
1. In the Deployment Wizard, click Edit > Preferences.

The Deployment Preferences window appears.
2. Enter 30000 in the Data Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 30000.

3. Enter 35000 in the Communication Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 35000.

4. If you use the computer on which you run the installation as a node, do the
following steps:
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a. Click Target Computer Settings.
b. Select localhost in the Target Computer field.
c. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.

Note: The RMI Registry Port is unavailable if you use localhost as a node.

Selecting the Analytics node components you are adding
For a Distributed Environment (Analytics Node only) installation, you can select
the components that you want to add to the environment.

You can install more IBM SPSS Collaboration and Deployment Services Server
instances. Or you can install more Analytics node instances without IBM SPSS
Collaboration and Deployment Services Server.

Each instance of IBM SPSS Collaboration and Deployment Services Server requires
a separate database on the database server on the data node computer.

Procedure
1. Distributed Environment (Analytics Node only)

2. Select one of the following options:
v Deploy another instance of the SPSS Collaboration & Deployment Service

Server

v Deploy other Analytical Server components

3. Click Next.

Specifying the target computers to install the server components
You must specify a different target computer for each IBM Predictive Customer
Intelligence node. A node can be installed on a computer or virtual machine, but
each node must be installed on a separate computer or virtual machine.

Before you begin

You must have root access on each computer on which you install a node.

You might have to change a setting in a configuration file on your target computer
to allow the Deployment Wizard to access the computer as root. Use the
following steps if you receive a message that says the connection to the target
computer was refused:
1. On the target computer, go to the /etc/ssh directory and open sshd_config for

editing.
2. Change the PermitRootLogin property to yes.
3. Save the file, and restart the server for the change to take effect.

Procedure
1. On the Specify Target Computers pages of the Deployment Wizard, enter the

name or IP address of the computer on which you install a node in the Target
Computer box.
The Deployment Wizard prompts you for each node computer.
If you install a node on the computer where you run the Deployment Wizard,
you can enter localhost.
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2. Click Add.
When you enter a computer other than localhost, in the Target Computer
Credentials box, do the following steps:
a. Enter the User ID and Password for the root user or a user with sudo

permissions.

Important: Ensure that you enter the credentials for the root user or a user
with sudo permissions on the target computer.

b. Click Test Login.
c. Click Add.

The computer that you entered appears in the Selected target computers
box.

3. Do the following steps if you install while your Linux iptables run.
a. Click Edit > Preferences.
b. Click Target Computer Settings.
c. Select the computer name or IP address in the Target Computer field.
d. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.
e. Enter the Data Port Number that you set in the RMI Registry Port field.

For example, enter 30000.

Note: If you use localhost as a node in the installation, the RMI Registry
Port is unavailable.

4. In the Selected target computers box, select the target computer, and click Test
Connections.

Important: Test Connections tests the connection, tests the credentials, and
locates or enables a deployment agent on the target computer. You must have
an active deployment agent on each target computer.
If you receive an error message after you click Test Connections, you might
have to change some settings on your computers.
v Edit your iptable settings or temporarily disable your firewall. For more

information, see “Computer firewall settings required for the installation” on
page 12.

v Compare and correct your domain name system (DNS) settings for each
computer. For example, type sudo system-config-network. Select DNS
configuration, and ensure that your host name domain and DNS search path
settings are correct.

v Ensure that the /etc/hosts file has the correct entries. For an example, see
“Test Connections validation errors” on page 70.

5. Click Next.
6. Repeat the steps for each computer on which you install a node.

Configuring parameters for a distributed installation
The Deployment Wizard displays some default values for each component of IBM
Predictive Customer Intelligence. You can accept the default values or change them
to suit your environment.

If you are prompted for users, the Deployment Wizard creates the users on the
appropriate target node computer, if they do not exist.
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Procedure

Enter values in each field on each page of the Deployment Wizard:
v Click Browse to browse the target computer's file system. It does not browse the

local computer from where you run the Deployment Wizard.
v For some values, such as passwords, default values are not provided. Ensure

that you enter all values on each page of the Deployment Wizard.

Table 11 includes the configuration parameters for IBM DB2.

Table 11. IBM DB2 configuration parameters for IBM DB2 client

Field Default or example value Description

DB2 Client Installation
Directory

/opt/ibm/db2/V10.1 The location where IBM DB2
client is to be installed on the
target computer.

DB2 Client Instance User
Name

db2inst1 The user ID for the DB2
client.

DB2 Instance Owner
Password

There is no default value for
this field.

The password for the DB2
client instance owner user.

The password cannot contain
more than 8 characters.

DB2 Client Instance Home
Directory

/home/db2inst1 The home directory for the
DB2 client instance owner
user on each node.

Table 12 includes the configuration parameters for WebSphere Application Server.

Table 12. WebSphere Application Server installation parameters

Field Default or example value Description

WebSphere Installation
Directory

/opt/IBM/WebSphere/
AppServer

The location where the
WebSphere Application
Server is to be installed.

Table 13 includes the configuration parameters for IBM SPSS Collaboration and
Deployment Server.

Table 13. IBM SPSS Collaboration and Deployment Server parameters

Field Default or example value Description

SPSS Collaboration and
Deployment Services Server
Installation Directory

/opt/IBM/SPSS/Deployment/
6.0/Server

The location where IBM SPSS
Collaboration and
Deployment Services is to be
installed.

WebSphere Profile Location /opt/IBM/WebSphere/
AppServer/profiles

The location where the
WebSphere profile is to be
created.

WebSphere Profile Default
Template Location

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located.

WebSphere Profile Name SPSSProfile The name of the WebSphere
profile that is to be used.

WebSphere Host Name This value is automatically
entered.

The name or IP address of
the Analytics node computer.

WebSphere Profile Node
Name

Node01 The name for the WebSphere
Application Server node.
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Table 13. IBM SPSS Collaboration and Deployment Server parameters (continued)

Field Default or example value Description

WebSphere Profile Cell
Name

Cell01 The name for the WebSphere
Application Server cell.

SPSS DB2 Database Host
Name

There is no default value for
this field.

The name or IP address of
the data node computer.

SPSS DB2 Database Port
Number

50000 The port number that is used
by IBM DB2.

SPSS DB2 Database Name SPSSDB
Important: You must change
this name. SPSSDB is the
default value that is used by
the Analytics node
components that were
configured as part of the
Default Environment
installation. You must use
another database name.

You must create this
database by running a script
after the installation is
complete.

The SPSS database that will
be used by the Analytics
node components.

SPSS DB2 Server Instance
User Name

db2inst1 The user ID that owns the
database instance.

SPSS DB2 Server Instance
Password

There is no default value for
this field.

The password for the DB2
instance owner user.

The password cannot contain
more than 8 characters.

SPSS Collaboration and
Deployment Service Server
Administrative User Name

admin The IBM SPSS Collaboration
and Deployment Services
administrative user.

SPSS Collaboration and
Deployment Service Server
Administrative Password

There is no default value for
this field.

The password for the IBM
SPSS Collaboration and
Deployment Services
administrative user.

Table 14 includes the configuration parameters for IBM SPSS Collaboration and
Deployment Server.

Table 14. IBM SPSS Collaboration and Deployment Server parameters

Field Default or example value Description

SPSS Modeler Server
Installation Directory

/usr/IBM/SPSS/
ModelerServer/16.0

The directory where the IBM
SPSS Modeler Server is to be
installed. This directory is on
the Analytics node computer.

SPSS Data Access Pack
Installation Directory

/opt/ibm/SDAP71 The directory where the IBM
SPSS Data Access Pack is to
be installed. This directory is
on the Analytics node
computer.
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Table 14. IBM SPSS Collaboration and Deployment Server parameters (continued)

Field Default or example value Description

SPSS Modeler Premium
Solution Publisher
Installation Directory

/opt/IBM/SPSS/
ModelerSolutionPublisher/
16.0

The directory where the IBM
SPSS Modeler Premium
Solution Publisher is to be
installed. This directory is on
the Analytics node computer.

SPSS Statistics Server
Installation Directory

/opt/IBM/SPSS/
StatisticsServer22

The directory where the IBM
SPSS Statistics Server is to be
installed. This directory is on
the Analytics node computer.
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Chapter 5. Installation of the client components

There are several client components that are included with IBM Predictive
Customer Intelligence. You can install the components as you require.

Important: Install the client components only after you successfully install the
server components.

Client components
Client components for IBM Predictive Customer Intelligence are available to be
installed.

For more information about installing and using the client components, see the
documentation provided with the component.

Important: After the client installation files are copied to your computer, some
paths for the compressed files can be long. You might need to use a decompression
utility other than the one provided by Microsoft Windows to decompress the files.

Database connectivity

IBM Data Server Runtime Client must be installed to enable connectivity to the
databases.

Predictive modeling and decision management

Install the following components so that you can modify or create predictive
models and so that you can perform decision management tasks:
v IBM SPSS Collaboration and Deployment Services Deployment Manager
v IBM SPSS Modeler Client Premium

Optionally, install the following components:
v IBM SPSS Statistics Client
v IBM SPSS Collaboration and Deployment Services Documentation
v IBM Analytical Decision Management Documentation
v IBM SPSS Modeler Premium Documentation

Business intelligence

Install IBM Cognos Framework Manager so that you can modify the reporting
model metadata.

Note: You must install IBM Data Server Runtime Client before you can use IBM
Cognos Framework Manager. Ensure that you restart the computer after you install
the IBM Data Server Runtime Client, and that you catalog the databases before you
use Framework Manager. Framework Manager is a 32-bit application, and requires
the 32-bit IBM Data Server Runtime Client.

Optionally, install the following components:
v IBM Cognos Business Intelligence Samples
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v IBM Cognos Dynamic Query Analyzer
v IBM Cognos for Microsoft Office
v IBM Cognos Lifecycle Manager
v IBM Cognos Software Development Kit
v IBM Cognos Supplementary Languages Documentation

Integration Bus

Install the following components:
v Integration Bus Toolkit
v WebSphere MQ for Windows

Use the Integration Bus Toolkit to create, manage, deploy, and delete message
flows and associated resources in a development environment.

Starting the Launchpad for the client components
Use the IBM Predictive Customer Intelligence Launchpad to start the Deployment
Wizard.

Procedure
1. Go to the directory where you downloaded the artifacts installation files.
2. Decompress the installation files.
3. Go to the disk1 directory where you decompressed the files.
4. Double-click Launchpad.exe or Launchpad64.exe.

Changing the temporary location for installation files
The Deployment Wizard uses a temporary directory for installation source files.
You must ensure that you are using a location that has adequate disk space for the
installation source files. If you do not have enough disk space in the default
location, you can change the location.

For example, the default location is . If space is limited on your C drive, you can
change the temporary location to another drive.

The temporary files include jar files that are used during the installation, which
you might want to delete after you complete the installation.

Procedure
1. In the Deployment Wizard, click Edit > Preferences.

The Deployment Preferences window appears.
2. In the Deployment Package Path box, select an existing location.
3. Click OK.

Starting the Deployment Wizard and installing the client components
Use the IBM Predictive Customer Intelligence Deployment Wizard to copy the
client installation files to your computer. You must run each installation program
individually after the client installation files are copied to your computer.
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Tip: You might need to adjust your Windows User Access Control (UAC) settings
so that you can run the installation program for the client components.

Procedure
1. In the Launchpad, click Deploy Client > Start the Predictive Customer

Intelligence Client Deployment Wizard.
2. On the Select Tasks panel, select whether you want 32- or 64-bit clients

installed, and click Next.
3. Select the clients for which you want to deploy the installation files, and click

Next.
4. Enter a location for each client component installer to be copied to. The default

is C:\IBM\PCI\.
5. On the Summary Panel, click Deploy all.

Note: The time to deploy the software is estimated by the Deployment
Wizard. The actual time required depends on a variety of factors, such as
network speed. In most cases, the deployments will take significantly less time
than what is initially displayed by the Deployment Wizard.

6. After the client installers are copied to your computer, you must install each
client individually by using its installer.

Installing IBM SPSS Collaboration and Deployment Services
Deployment Manager

You must install IBM SPSS Collaboration and Deployment Services Deployment
Manager to complete the configuration of IBM Predictive Customer Intelligence.

Procedure
1. Go to the install_location\Client\Analytics\IBM SPSS Collaboration and

Deployment Services Deployment Manager directory.
By default, the install_location is C:\IBM\PCI\.

2. Decompress the installation files.
3. In the decompressed folder, double-click install.exe to start the IBM SPSS

Collaboration and Deployment Services Deployment Manager installation.
4. Follow the steps in the wizard to install the client component.

For more information about the installation of Deployment Manager, see the
IBM SPSS documentation (www.ibm.com/support/knowledgecenter/
SS69YH_6.0.0).

Adding server connections for IBM SPSS Collaboration and
Deployment Services

You must add a connection to your IBM SPSS Collaboration and Deployment
Services repository in the IBM SPSS Collaboration and Deployment Services
Deployment Manager client.

After you add the connection, the server folder displays in the Content Explorer,
and you can log in to the server.

Procedure
1. Click Start > All Programs > IBM SPSS Collaboration and Deployment

Services > Deployment Manager > Deployment Manager 6.0.
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2. Click File > New > Content Server Connection.
3. In the Connection Name box, enter a name for your Collaboration and

Deployment Services repository. For example, enter SPSS.
4. In the Server URL box, enter the name or IP address of the Predictive

Analytics node computer and the port number, and click Finish.
The default port number that is used by the WebSphere Application Server
instance is 9080.

5. Double-click the connection name that you created.
6. In the User ID box, enter admin.
7. In the Password box, enter admin.
8. Click OK.
9. Click File > New > Administered Server Connection.

10. In the Name box, enter a name for the repository server, and click Next. For
example, enter SPSS.

11. In the Server URL box, enter the name or IP address of the Predictive
Analytics node computer and the port number, and click Finish.
The default port number that is used by the WebSphere Application Server
instance is 9080.

12. Double-click the server connection name that you created.
13. In the User ID box, enter admin.
14. In the Password box, enter admin.
15. Click OK.

Adding users and groups and server definitions to IBM SPSS
Collaboration and Deployment Services

You use IBM SPSS Collaboration and Deployment Services Deployment Manager
to manage users and groups. You must add an administrator user and a modeler
user for IBM Predictive Customer Intelligence. You must also add a server
definition.

Procedure
1. In Deployment Manager, on the Content Explorer tab, expand Resource

Definiton.
2. Add an admin user.

a. Right-click Credentials, and click New > Credentials Definition.
b. In the Name box, enter admin, and click Next.
c. In the User ID box, enter admin.
d. In the Password box, enter a password. For example, enter spss.
e. In the Security Provider box, select Local User Repository.
f. Click Finish.

3. Add a modeler user.
a. Right-click Credentials, and click New > Credentials Definition.
b. In the Name box, enter modeler, and click Next.
c. In the User ID box, enter a local user on the Predictive Analytics node

computer.
d. In the Password box, enter a password for that user.
e. In the Security Provider box, select Local User Repository.
f. Click Finish.
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4. Add a localhost server definition.
a. Right-click Servers, and click New > Server Definition.
b. In the Name box, enter localhost.
c. In the Type box, select Content Repository Server.
d. Click Next.
e. In the Server URL box, enter the name or IP address of the Analytics node

computer and the port number, and click Finish.
The default port number that is used by the WebSphere Application Server
instance is 9080.

5. Add a modeler server definition.
a. Right-click Servers, and click New > Server Definition.
b. In the Name box, enter modeler, and click Next.
c. In the Type box, select Modeler Server, and click Next.
d. In the Host box, enter the name or IP address of the Analytics node

computer.
e. In the Port box, enter 28053.

Note: If the connection is not successful, restart Modeler Server.
f. In the Default data path box, enter the path to the data folder on Analytics

node computer. For example, enter C:\Program Files\IBM\SPSS\
ModelerServer\16.

g. Click Finish.

Installing IBM SPSS Modeler Client
You must install IBM SPSS Modeler Client to configure the Next Best Action
Optimizer connectors for IBM Predictive Customer Intelligence.

Procedure
1. Go to the install_location\Client\Analytics\IBM SPSS Modeler Client

directory.
By default, the install_location is C:\IBM\PCI\.

2. Decompress the installation files.
3. Double-click setup.exe to start the IBM SPSS Modeler Client installation.
4. Follow the steps in the wizard to install the client component.

Installation of the Integration Bus clients
For IBM Predictive Customer Intelligence, you must install MQ Explorer,
Integration Toolkit, and Integration Explorer.

Installing MQ Explorer
IBM Integration Explorer client application requires that MQ Explorer is installed
on the same computer.

Procedure
1. Go to the install_location\Client\Integration Bus\IBM Integration Bus

directory.
By default, the install_location is C:\IBM\PCI\.
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2. Decompress the installation file that is named
IIB_IBToolkit_WS_MQ_WINDOWS_X86-64.zip.

3. In the decompressed directory, go to the integrationbus\
WebSphere_MQ_V7.5.0.1 directory, and double-click MQLaunch.exe.

4. Click Software Requirements, and ensure that you are using a supported
operating system.

5. Click Network Configuration, and select No for Configuring WebSphere MQ
for Windows domain users.

6. Click WebSphere MQ Installation, and click Launch IBM Websphere MQ
Installer.

7. On the Setup Type page, select Custom, and click Next.
8. On the Features page, select only MQ Explorer to be installed.

Ensure that all other features are set to Do not install this feature.
9. Click Next.

10. Click Install, and click Finish.

Installing the Integration Bus client applications
Install the IBM Predictive Customer Intelligence Integration Bus client applications.
The applications include IBM Integration Toolkit and IBM Integration Explorer.

Before you begin

Ensure that MQ Explorer is already installed.

Procedure
1. Go to the directory where you decompressed the Integration Bus client

application installers.
2. In the decompressed directory, in the integrationbus directory, double-click

mqsilaunchpad.exe.
3. Select the check boxes for IBM Integration Toolkit, and IBM Integration

Explorer. Clear the check box for IBM Integration Bus.
If it is not already installed, IBM Installation Manager is installed with IBM
Integration Toolkit.

4. Click Launch Installation for IBM Integration Bus.
IBM Installation Manager appears.

5. Follow the steps in IBM Installation Manager to install IBM Integration Toolkit.
6. When you are prompted to open a product, select None, and click Finish.

The installer for IBM Integration Explorer appears.
7. Follow the steps in the wizard to install IBM Integration Explorer.

Connecting to your WebSphere MQ broker
Connect to the queue manager you created on the IBM Predictive Customer
Intelligence Integration Bus node computer.

Procedure
1. From the Start menu, click All Programs > IBM WebSphere MQ >

WebSphere MQ Explorer.
The first time that you start WebSphere MQ Explorer, you are prompted for a
workspace location.
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2. In the MQ Explorer - Navigator, under IBM WebSphere MQ, right-click
Queue Managers, and select Add Remote Queue Manager.

3. Enter the name of your queue manager, select Connect directly, and click
Next. For example, enter pciqmgr.

4. In the Connection details section, enter the following information, and click
Next.
a. In the Host name or IP address box, enter the information for your

Integration Bus node computer.
b. In the Port number box, enter the listener port number. The default is

1414.
c. In the Server-connection channel box, enter SYSTEM.BKR.CONFIG

5. On the Specify user identification details page, select Enable user
identification.

6. In the Userid box, enter mqm.
7. The first time that you add a user, you must enable password saving. Click

Passwords Preferences Page, and then select Save passwords to file to enable
the feature, and click OK.

8. Click Enter password.
9. Enter the user's password, and click OK.

10. Click Finish. The queue manager appears in the list, and the status appears as
running.

Installing Framework Manager for IBM Predictive Customer Intelligence
Install IBM Cognos Framework Manager to create or edit models and publish
packages for IBM Cognos Business Intelligence.

Procedure
1. Go to the install_location\Client\Business Intelligence\IBM Cognos

Framework Manager directory.
By default, the install_location is C:\IBM\PCI\.

2. Decompress fm_10.2.1_win_ml.tar.gz, and then decompress
fm_10.2.1_win_ml.tar.

3. Go to the win32 directory, and double-click the issetup.exe file.
4. Follow the steps in the wizard to install the product.
5. When notified with an information message about installing the

Supplementary Languages Documentation, click OK

6. On the last page of the installation wizard, select Start IBM Cognos
Configuration to configure Cognos Framework Manager.

7. Click Finish.
8. In IBM Cognos Configuration, in the Explorer panel, select Environment.
9. In the Gateway URI value, change localhost to the name or IP address of the

Business Intelligence (BI) node computer.
10. In the Dispatcher URI for external applications value, change localhost to

the name or IP address of the Business Intelligence (BI) node computer.
11. In the Dispatcher URI for external applications value, change 9300 to 9080.

9080 is the port number that is used by WebSphere Application Server for IBM
Cognos Business Intelligence.

12. Click File > Save.
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Chapter 6. Installation of the artifacts

The artifacts include report content and workflows for IBM Predictive Customer
Intelligence.

You must install the artifacts onto a computer that is running a Microsoft Windows
operating system. Then, you must copy the artifacts to their respective node
computers.

Starting the Deployment Wizard to install the artifacts
Use the Launchpad to start the IBM Predictive Customer Intelligence artifacts
Deployment Wizard.

You must run the Deployment Wizard on a computer that is running a Microsoft
Windows operating system.

Tip: You might need to adjust your Windows User Access Control (UAC) settings
so that you can run the installation program for the client components.

Tip: You can change the temporary location that the Deployment Wizard uses for
the installation files. For more information, see “Changing the temporary location
for installation files” on page 44.

Procedure
1. Go to the directory where you downloaded the artifacts installation files.
2. Decompress the installation files.
3. Go to the disk1 directory where you decompressed the files.
4. Double-click Launchpad.exe or Launchpad64.exe.
5. Click Deploy Artifacts > Start the Predictive Customer Intelligence Artifact

Deployment Wizard.

Important: In some cases, after you accept the license agreement, the
Deployment Wizard might appear behind other open windows. If you do not
see the Deployment Wizard, check for the icon in the taskbar.

Configuring parameters for the artifacts installation
You can select the installation location for the IBM Predictive Customer Intelligence
artifacts.

Procedure
1. On the Select Tasks page, click Next.
2. On the Configure Parameters page, enter the location to install the artifacts on

the computer from where you are running the installation.
The default is C:\IBM\PCI. All of the artifacts are installed to the same location.

3. Click Next.
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Starting the installation of the artifacts
After you enter all of the required fields in the Deployment Wizard, you can start
the installation of the artifacts.

Procedure

On the Summary Panel of the Deployment Wizard, click Deploy all.
If you choose to deploy the tasks individually, you must click Deploy task for each
task in the order that the tasks appear on the Summary panel.

Note: The time to deploy the software is estimated by the Deployment Wizard.
The actual time required depends on a variety of factors, such as network speed.
In most cases, the deployments will take significantly less time than what is
initially displayed by the Deployment Wizard.

Configure IBM Predictive Customer Intelligence artifacts
To configure the Predictive Customer Intelligence artifacts, you must create a
database, publish content to IBM Cognos Business Intelligence, and copy files to
the Predictive Analytics node and to the computer running Enterprise Marketing
Management.

Creating the IBM Predictive Customer Intelligence database
You must run a script to create the Predictive Customer Intelligence database, and
then run another to populate the database.

The scripts create and populate a database that is named PCI on your IBM DB2
database server. The scripts are available in the directory where you installed the
artifacts.

Procedure
1. Copy the artifacts from the computer where you installed them to the data

node computer and decompress the artifact files. For example, decompress the
artifacts to a directory on the data node computer that is named
/opt/ibm/PCI/Database.

2. Log on to the data node computer as root user.
3. Open a terminal window, and go to the directory where you installed the

artifacts. For example, go to the /opt/ibm/PCI/Database directory.
4. Type the following command to change the permissions for the files:

chmod -R 755 *

5. Change to the database instance owner. For example, su db2inst1.
6. Run sh ./Install_DB.sh to create the database.
7. Run sh ./Load_Data.sh to populate the database.

Configure the BI node artifacts
To configure the IBM Predictive Customer Intelligence artifacts for the Business
Intelligence node, you must move some files to the IBM Cognos BI installation
location, create a connection to the PCI database, and deploy IBM Cognos reports.

Moving content to the IBM Cognos BI installation location
After you install the IBM Predictive Customer Intelligence artifacts, you must
move some files to the IBM Cognos Business Intelligence installation location.
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Procedure
1. Copy the artifacts from the computer where you installed them to the Business

Intelligence node computer. For example, copy the artifacts to a directory
named /opt/ibm/PCI/Business Intelligence/.

2. Log on to the BI node computer.
3. Go to the Exports directory where you installed the BI artifacts. For example,

go to the /opt/ibm/PCI/Business Intelligence/Exports directory.
4. Copy the IBM PCI Cognos Content.zip file to the IBM Cognos BI

installation_location/deployment directory.
5. Go to the Report Images directory where you installed the artifacts. For

example, go to the /opt/ibm/PCI/Business Intelligence/Report Images
directory.

6. Extract the Report Images.zip file to the IBM Cognos BI
installation_location/webcontent directory.
You should have an installation_location/webcontent/ReportImages directory
that contains the image files.

Important: The ReportImages directory must not have a space in the name
after you copy it to the IBM Cognos BI installation_location\webcontent
directory.

Creating a database connection to the PCI database
To connect to the PCI database on your Business Intelligence node computer, you
must first catalog the database server, and then catalog the PCI database. Then, you
must create a database connection in IBM Cognos Administration.

Procedure
1. Log on to the BI node computer.
2. In a terminal window, change to the database instance owner. For example, su

db2inst1.
3. Enter the following command to catalog the database node:

db2 catalog tcpip node NODE_NAME remote data_node_name server PORT_NUMBER

NODE_NAME can be any value. PORT_NUMBER is 50000 by default.
4. Enter the following command to catalog the PCI database:

db2 catalog database PCI at node NODE_NAME authentication server

Creating a data source connection to the PCI database in IBM
Cognos BI
You must create a data source connection to the PCI database in IBM Cognos BI,
and then you must deploy the reports.

Procedure
1. Open a web browser.
2. Go to the IBM Cognos BI portal URL. For example, go to http://bi_node_name/

ibmcognos/.
3. On the Welcome page, click Administer IBM Cognos Content.
4. Create a data source connection to the PCI database.

a. Click the Configuration tab, and click Data Source Connections.
b. Click the New Data Source button.
c. In the Name box, type PCI and then click Next.
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d. In the connection page, select IBM DB2, ensure that Configure JDBC
connection is selected, and click Next.
The connection string page for the selected database appears.

e. In the DB2 database name field, enter PCI.
f. Leave DB2 connect string blank.
g. Under Signons, select both Password and Create a signon that the

Everyone group can use, type the user ID and password for the DB2
instance owner user that you used to create the database, and click Next.

h. In the Server name box, enter the name or IP address of your data node
computer.

i. In the Port number box, enter the DB2 port number. The default is 50000.
j. In Database name, enter PCI.

Tip: To test whether the parameters are correct, click Test the connection.
After you test the connection, click OK to return to the connection page.

k. Click Close, Close, and then Finish.
5. Deploy the IBM Cognos BI reports.

a. On the Configuration tab, click Content Administration.
b. On the toolbar, click the New Import button.
c. In the Deployment Archive pane, select IBM PCI Cognos Content, and

click Next.
d. In the Public Folders Content pane, select IBM Predictive Customer

Intelligence, leave the Options as default, and click Next.
e. In the Specify the general options pane, accept the defaults, and click Next.
f. On the Review the summary page, click Next.
g. On the Select an action page, select Save and run once, and click Finish.
h. On the Run with options page, accept the defaults, and click Run, and then

click OK.
i. Click the Home button in IBM Cognos Administration.

The Predictive Customer Intelligence reports are available from the home
page.

Configuring the Next Best Action Optimizer connectors
Use the Next Best Action Optimizer (NBAOPT) connectors with IBM SPSS Modeler
for IBM Predictive Customer Intelligence. With the NBAOPT connectors installed,
you can run NBAOPT Studio from IBM SPSS Modeler.

You must copy the NBAOPT connectors to the location where IBM SPSS Modeler
Client is installed.

For more information about using the NBAOPT connectors, see the IBM Predictive
Customer Intelligence Solution Guide.

Procedure

Copy the pci.NBAOPT directory where you installed the NBAOPT artifacts to the
ext\lib directory where IBM SPSS Modeler Client is installed. For example, copy
the pci.NBAOPT directory to the C:\Program Files\IBM\SPSS\Modeler\16\ext\lib
directory.
After you copy the folder, you should have the following path:
C:\Program Files\IBM\SPSS\Modeler\16\ext\lib\pci.NBAOPT
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Configuring the Enterprise Marketing Management connectors
If you are using IBM Enterprise Marketing Management (EMM), IBM Predictive
Customer Intelligence provides two connectors between IBM Interact and IBM
SPSS Collaboration and Deployment Scoring Service. The connectors override the
score that is supplied by the IBM EMM campaign and also extend IBM Interact's
learning module to monitor visitor actions and propose optimal offers.

To configure the connectors, you must copy them to the EMM installation location.

Do not configure the connectors if you are not using IBM Enterprise Marketing
Management.

Important: The EMM connectors can be used only with IBM Enterprise Marketing
Management version 9.0 or 9.1.

Procedure

Copy the artifacts from the EMMConnectors directory where you installed the EMM
artifacts to the Connectors directory where EMM is installed. For example, copy
the files to the /opt/IBM/EMM/Interact/Connectors directory.
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Chapter 7. Copying the license files to each component
computer

After you install IBM Predictive Customer Intelligence, you must ensure that a
swidtag file and license directory exists on each computer on which you installed
a Predictive Customer Intelligence component.

The swidtag file and license directory must exist on each server node computer
and each computer on which you install a client that is used with Predictive
Customer Intelligence.

Important: Do not rename the directories or files.

Procedure
1. Copy the swidtag file from the iso-swid directory where you installed the

artifacts to each computer where you installed a Predictive Customer
Intelligence component.
For example, copy the file so that you have an /opt/IBM/PCI/iso-swid
directory that contains a swidtag file.
If a iso-swid directory exists on the computer, do not overwrite the directory.
Add the swidtag file to the existing directory.

2. Copy the license directory from the directory where you installed the artifacts
to each component computer.
For example, copy the directory and contents so that you have an
/opt/IBM/PCI/license directory that contains the license files.
If the license directory exists on the computer, you do not need to replace it.

Results

The following folders must exist on each computer on which you installed a
Predictive Customer Intelligence component:
v On server computers:

/opt/IBM/PCI/license (containing the product license files)
/opt/IBM/PCI/iso-swid (containing the product swidtag file)

v On client computers:
C:\IBM\PCI\license (containing the product license files)
C:\IBM\PCI\iso-swid (containing the product swidtag file)
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Chapter 8. Stop and start solution software services

IBM Predictive Customer Intelligence is an integrated solution that includes many
products. If you must stop the services, you must do so in the correct order. The
product services must also be started in the correct order.

Stop solution services
Stop the IBM Predictive Customer Intelligence node services in the following
order:
1. Business Intelligence (BI) node
2. Integration Bus node
3. Predictive Analytics node
4. data node

Stopping services on the BI node computer
You must stop the IBM Cognos Business Intelligence services and IBM HTTP
Server on the IBM Predictive Customer Intelligence Business Intelligence (BI) node
computer.

You stop the IBM Cognos BI services by stopping the WebSphere Application
Server profile where IBM Cognos BI is running.

Procedure
1. Log in to the BI node computer as root.
2. Go to the WebSphere Application Server profile directory when IBM Cognos BI

is running. For example, go to /opt/IBM/WebSphere/AppServer/profiles/
COGNOSProfile/bin.

3. Enter the following command:
./stopServer.sh server1

4. Go to the IBM HTTP Server bin directory. For example, go to
/opt/IBM/HTTPServer/bin.

5. Enter the following command:
./apachectl -f ./conf/httpd.conf -k stop

Stopping services on the Integration Bus node computer
You must stop the IBM Integration Bus services on the IBM Predictive Customer
Intelligence Integration Bus node computer.

Procedure
1. Log in to the Integration Bus node computer as root.
2. Change to the mqm user. For example, enter the following command:

su -mqm

3. Go to the IBM Integration Bus bin directory. For example, go to
/opt/ibm/mqsi/9.0.0.0/bin.

4. Enter the following command:
./mqsistop pcibroker -i
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5. Enter the following command to verify that the services are stopped:
./mqsilist pcibroker –e pcigroup

Stopping services on the Analytics node computer
You must stop the IBM SPSS services on the IBM Predictive Customer Intelligence
Predictive Analytics node computer.

Procedure
1. Log in to the Analytics node computer as root.
2. Go to the WebSphere Application Server SPSSProfile/bin directory. For

example, go to /opt/IBM/WebSphere/AppServer/profiles/SPSSProfile/bin.
3. Enter the following command:

./stopServer.sh server1

4. Go to the IBM SPSS Modeler Server directory. For example, go to
/usr/IBM/SPSS/ModelerServer/16.0.

5. Enter the following command:
./modelersvr.sh stop

6. To verify whether any services are still running enter the following command:
ps -ef | grep statisticsd

7. To stop any services that are still running enter the following command:
kill -9 'cat statisticsd.pid'

Stopping services on the data node computer
You must stop the IBM DB2 instance on the IBM Predictive Customer Intelligence
data node computer.

Procedure
1. Log in to the data node computer as root.
2. In a terminal window, type the following command to change the DB2 instance

owner:
su - db2inst1

3. Enter the following command to stop the DB2 administration server:
db2stop

Start solution services
Start the IBM Predictive Customer Intelligence node services in the following
order:
1. data node
2. Predictive Analytics node
3. Integration Bus node
4. Business Intelligence (BI) node

Starting services on the data node computer
You must start the IBM DB2 instance on the IBM Predictive Customer Intelligence
data node computer.

Procedure
1. Log in to the data node computer as root.
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2. In a terminal window, type the following command to change the DB2 instance
owner:
su - db2inst1

3. Enter the following command to stop the DB2 administration server:
db2start

Starting services on the Analytics node computer
You must start the IBM SPSS services on the IBM Predictive Customer Intelligence
Predictive Analytics node computer.

Procedure
1. Log in to the Analytics node computer as root.
2. Go to the WebSphere Application Server SPSSProfile/bin directory. For

example, go to /opt/IBM/WebSphere/AppServer/profiles/SPSSProfile/bin.
3. Enter the following command:

./startServer.sh server1

4. Go to the IBM SPSS Modeler Server directory. For example, go to
/usr/IBM/SPSS/ModelerServer/16.0.

5. Enter the following command:
./modelersrv.sh start

Starting services on the Integration Bus node computer
You must start the IBM Integration Bus services on the IBM Predictive Customer
Intelligence Integration Bus node computer.

Procedure
1. Log in to the Integration Bus node computer as root.
2. Change to the mqm user. For example, enter the following command:

su -mqm

3. Go to the IBM Integration Bus bin directory. For example, go to
/opt/ibm/mqsi/9.0.0.1/bin.

4. Enter the following command:
./mqsistart pcibroker -i

5. Enter the following command to verify that the services are started:
./mqsilist pcibroker –e pcigroup

Starting services on the BI node computer
You must start the IBM Cognos Business Intelligence services and IBM HTTP
Server on the IBM Predictive Customer Intelligence Business Intelligence (BI) node
computer.

You start the IBM Cognos BI services by starting the WebSphere Application Server
profile where IBM Cognos BI is running.

Procedure
1. Log in to the BI node computer as root.
2. Go to the WebSphere Application Server profile directory when IBM Cognos BI

is running. For example, go to /opt/IBM/WebSphere/AppServer/profiles/
COGNOSProfile/bin.
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3. Enter the following command:
./startServer.sh server1

4. Go to the IBM HTTP Server bin directory. For example, go to
/opt/IBM/HTTPServer/bin.

5. Enter the following command:
./apachectl -f ./conf/httpd.conf -k start
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Chapter 9. Switch software tags for your installation

If you change your usage of IBM Predictive Customer Intelligence, such as to a
non-production environment from a production environment, you must switch the
software tags for your installation.

Starting the ILMT Utility to change software tags
Use the artifacts Launchpad to start the IBM Licence Metric Tool (ILMT) Utility to
change IBM Predictive Customer Intelligence software tags.

Procedure
1. Go to the directory where you downloaded the artifacts installation files.
2. Decompress the installation files.
3. Go to the disk1 directory where you decompressed the files.
4. Double-click Launchpad.exe or Launchpad64.exe.
5. Click Switch Software Tags > Start the IBM Predictive Customer Intelligence

ILMT Utility.

Important: If a message directs you to verify that the application was installed
correctly or to reinstall it, you can safely ignore this message. The utility will
function correctly.

Switching software tags
Switch your IBM Predictive Customer Intelligence software tags if your usage
changes. For example, if you installed the solution initially as a non-production
environment but want to move it to a production environment, you must switch
the software tags.

Procedure
1. On the Select Tasks page of the Deployment Wizard, select the option to

switch your tags:
v Select Switch from Production to Non-Production if you initially installed

Predictive Customer Intelligence to a production environment.
v Select Switch from Non-Production to Production if you initially installed

Predictive Customer Intelligence to a non-production environment.
2. Click Next.
3. On the Configuration Parameters page, enter the location to where you want

to deploy the updated software tags, and click Next.
4. Click Deploy all.

After the software tag file is deployed, you must copy it to each computer on
which a Predictive Customer Intelligence node or client is installed.

Updating your software tag file
After you use the ILMT utility to change your IBM Predictive Customer
Intelligence software tag, you must copy the updated file to each computer on
which a component is installed. You must replace the existing file with the
updated file.
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Copy the software tag file to each computer on which a Predictive Customer
Intelligence server or client component is installed.

Procedure
1. Copy the iso-swid directory and contents from the directory where you

updated the license files to each computer on which you install a Predictive
Customer Intelligence component.
For example, copy the directory and contents so that you replace the
/opt/IBM/PCI/iso-swid directory. The iso-swid directory should contain a
swidtag file.

2. Delete the existing swidtag file.
You should have only one swidtag file in the directory for the IBM Predictive
Customer Intelligence components.
If you deployed the samples, you should also have a swidtag file for the
samples in the directory.

Note: If you run the ILMT Utility on a computer where you installed a
Predictive Customer Intelligence component, and you use the same directory,
the .swidtag is overwritten with the updated file. You must, however, still copy
the new .swidtag file to all of the other computers that have a Predictive
Customer Intelligence component installed.
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Chapter 10. Uninstallation of the server components

Follow the uninstall instructions for each of the IBM Predictive Customer
Intelligence components to uninstall the product.

Uninstalling components from the Predictive Analytics node computer
Follow the uninstall instructions for each component on the IBM Predictive
Customer Intelligence Analytics node computer.

Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(www.ibm.com/support/knowledgecenter/SSEPGG_10.1.0).
2. To uninstall IBM SPSS Collaboration and Deployment Services, see the IBM

SPSS documentation (www.ibm.com/support/knowledgecenter/SS69YH_6.0.0).
a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

3. To uninstall WebSphere Application Server, see the WebSphere documentation
(www.ibm.com/support/knowledgecenter/SSEQTP_8.5.5).
a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/ibm/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh server1.

4. To uninstall IBM Installation Manager, see the IBM Installation Manager
information center (pic.dhe.ibm.com/infocenter/install/v1r6).
a. Go to the /var/ibm/InstallationManager/uninstall directory, and run

uninstall.
b. Follow the steps to uninstall IBM Installation Manager.

5. Remove the licence and iso-swid directories. For example, if you used the
default path, /opt/IBM/PCI, remove the /opt/IBM/PCI/license and
/opt/IBM/PCI/iso-swid directories.

Uninstalling components from the BI node computer
Follow the uninstall instructions for each component on the IBM Predictive
Customer Intelligence Business Intelligence (BI) node computer.

Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(www.ibm.com/support/knowledgecenter/SSEPGG_10.1.0).
2. To uninstall IBM Cognos Business Intelligence, see the IBM Cognos BI

documentation (www.ibm.com/support/knowledgecenter/SSEP7J_10.2.1).
a. Go to the /opt/ibm/cognos/c10_64/uninstall directory.
b. Type ./uninst -u, and press Enter.
c. From the Start menu, click All Programs > IBM Cognos 10 - 64 > Uninstall

IBM Cognos > Uninstall IBM Cognos.
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d. Follow the steps to uninstall the product.
3. To uninstall IBM HTTP Server, see the IBM HTTP Server for WebSphere

Application Server documentation (www.ibm.com/support/knowledgecenter/
SSEQTJ_8.5.5).
a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

4. To uninstall WebSphere Application Server, see the WebSphere documentation
(www.ibm.com/support/knowledgecenter/SSEQTP_8.5.5).
a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/ibm/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh server1.

5. To uninstall IBM Installation Manager, see the IBM Installation Manager
information center (pic.dhe.ibm.com/infocenter/install/v1r6).
a. Go to the /var/ibm/InstallationManager/uninstall directory, and run

uninstall.
b. Follow the steps to uninstall IBM Installation Manager.

6. Remove the licence and iso-swid directories. For example, if you used the
default path, /opt/IBM/PCI, remove the /opt/IBM/PCI/license and
/opt/IBM/PCI/iso-swid directories.

Uninstalling components from the Integration Bus node computer
Follow the uninstall instructions for each component on the IBM Predictive
Customer Intelligence Integration Bus node computer.

Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(www.ibm.com/support/knowledgecenter/SSEPGG_10.1.0).
2. To uninstall IBM Integration Bus, see the IBM Integration Bus documentation

(www.ibm.com/support/knowledgecenter/SSMKHH_9.0.0).
3. To uninstall WebSphere MQ, see the WebSphere MQ documentation

(www.ibm.com/support/knowledgecenter/SSFKSJ_7.5.0).
4. Remove the licence and iso-swid directories. For example, if you used the

default path, /opt/IBM/PCI, remove the /opt/IBM/PCI/license and
/opt/IBM/PCI/iso-swid directories.

Uninstalling components from the data node computer
Follow the uninstall instructions for each component on the IBM Predictive
Customer Intelligence data node computer.

Procedure
1. To uninstall IBM DB2, see the IBM DB2 documentation (www.ibm.com/

support/knowledgecenter/SSEPGG_10.1.0).
2. Remove the licence and iso-swid directories. For example, if you used the

default path, /opt/IBM/PCI, remove the /opt/IBM/PCI/license and
/opt/IBM/PCI/iso-swid directories.
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Appendix A. Troubleshooting

This section contains troubleshooting information for the IBM Predictive Customer
Intelligence installation.

Troubleshooting a problem
Troubleshooting is a systematic approach to solving a problem. The goal of
troubleshooting is to determine why something does not work as expected and
how to resolve the problem.

Review the following table to help you or customer support resolve a problem.

Table 15. Troubleshooting actions and descriptions

Actions Description

A product fix might be available to resolve
your problem.

Apply all known fix packs, or service levels,
or program temporary fixes (PTF).

Look up error messages by selecting the
product from the IBM Support Portal, and
then typing the error message code into the
Search support box (http://www.ibm.com/
support/entry/portal/).

Error messages give important information
to help you identify the component that is
causing the problem.

Reproduce the problem to ensure that it is
not just a simple error.

If samples are available with the product,
you might try to reproduce the problem by
using the sample data.

Ensure that the installation successfully
finished.

The installation location must contain the
appropriate file structure and the file
permissions. For example, if the product
requires write access to log files, ensure that
the directory has the correct permission.

Review all relevant documentation,
including release notes, technotes, and
proven practices documentation.

Search the IBM Knowledge Center to
determine whether your problem is known,
has a workaround, or if it is already
resolved and documented.

Review recent changes in your computing
environment.

Sometimes installing new software might
cause compatibility issues.

If the items in the table did not guide you to a resolution, you might need to
collect diagnostic data. This data is necessary for an IBM technical-support
representative to effectively troubleshoot and assist you in resolving the problem.
You can also collect diagnostic data and analyze it yourself.

Troubleshooting resources
Troubleshooting resources are sources of information that can help you resolve a
problem that you are having with an IBM product.

Support Portal

The IBM Support Portal is a unified, centralized view of all technical support tools
and information for all IBM systems, software, and services.
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The IBM Support Portal lets you access all the IBM support resources from one
place. You can tailor the pages to focus on the information and resources that you
need for problem prevention and faster problem resolution. Familiarize yourself
with the IBM Support Portal by viewing the demo videos (https://www.ibm.com/
blogs/SPNA/entry/the_ibm_support_portal_videos).

Find the content that you need by selecting your products from the IBM Support
Portal (http://www.ibm.com/support/entry/portal).

Before contacting IBM Support, you will need to collect diagnostic data (system
information, symptoms, log files, traces, and so on) that is required to resolve a
problem. Gathering this information will help to familiarize you with the
troubleshooting process and save you time.

Service request

Service requests are also known as Problem Management Reports (PMRs). Several
methods exist to submit diagnostic information to IBM Software Technical Support.

To open a PMR or to exchange information with technical support, view the IBM
Software Support Exchanging information with Technical Support page
(http://www.ibm.com/software/support/exchangeinfo.html).

Fix Central

Fix Central provides fixes and updates for your system's software, hardware, and
operating system.

Use the pull-down menu to navigate to your product fixes on Fix Central
(http://www.ibm.com/systems/support/fixes/en/fixcentral/help/
getstarted.html). You may also want to view Fix Central help.

IBM developerWorks

IBM developerWorks® provides verified technical information in specific
technology environments.

As a troubleshooting resource, developerWorks provides easy access to the most
popular practices, in addition to videos and other information: developerWorks
(http://www.ibm.com/developerworks).

IBM Redbooks

IBM Redbooks® are developed and published by the IBM International Technical
Support Organization, the ITSO.

IBM Redbooks (http://www.redbooks.ibm.com) provide in-depth guidance about
such topics as installation and configuration and solution implementation.

Software support and RSS feeds

IBM Software Support RSS feeds are a quick, easy, and lightweight format for
monitoring new content added to websites.
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After you download an RSS reader or browser plug-in, you can subscribe to IBM
product feeds at IBM Software Support RSS feeds (https://www.ibm.com/
software/support/rss).

Log files

Log files can help you troubleshoot problems by recording the activities that take
place when you work with a product.

Error messages

The first indication of a problem is often an error message. Error messages contain
information that can be helpful in determining the cause of a problem.

Launchpad does not launch
If the IBM Predictive Customer Intelligence Launchpad does not launch, ensure
that you have completed all of the prerequisite tasks and installed all of the
required rpm packages.

Launchpad does not start
You must have a Firefox web browser that is installed and set as your default web
browser on the computer from where you run the IBM Predictive Customer
Intelligence installation. Firefox must be version 17 as a minimum and version 20
at the latest.

If you have another browser that is set as your default and want to keep your
existing default browser, you can temporarily use a supported browser for the
installation.

Procedure
1. On the computer from where you run the installation, download a supported

web browser. For example, download Firefox version 20.
2. Decompress the downloaded file if necessary.
3. In a terminal window, type the following command:

export BROWSER=/path_to_supported_browser

4. Then, start the Launchpad by typing the following command:
./launchpad.sh

The Launchpad should appear in the supported browser.

Deployment Wizard does not save configurations
If you save your configurations in Deployment Wizard, use Save As instead of
Save.

If you click File > Save, any values that you entered are not saved when you
reopen the Deployment Wizard.

You can resolve this issue by clicking File > Save As to save your configuration.
Ensure that you enter a new name for the saved configuration.

When you open the Deployment Wizard, and open your saved configuration, the
settings you entered appear.
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Test Connections validation errors
If you click the Test Connections button in the IBM Predictive Customer
Intelligence installer and you receive an error, use the following tips to verify
communication between the Deployment Wizard and the target computer.
v Ensure that you entered a valid host name or IP address.
v Ensure that you can ping the target computer from the computer where you are

running the installation.
v Ensure that your firewall is disabled or that the ports required for the

Deployment Wizard are open on all computers.
v Ensure that all of your node computers have valid entries in the /etc/hosts file

on each node. You must include each node computer in the /etc/hosts files.
For example, ensure that your hosts file contains values such as the following
values:
127.0.0.1 localhost.localdomain localhost
##.##.##.## node_server1.domain.com node_server1
##.##.##.## node_server2.domain.com node_server2
##.##.##.## node_server3.domain.com node_server3
##.##.##.## node_server4.domain.com node_server4

v Ensure that you have correct entries in the /etc/resolv.conf file.

Timeout errors during installation
If you encounter timeout errors during the installation, you can continue the
installation by running each deployment task individually.

Depending on your computer's network speed, you might encounter timeouts as
processes can take some time to complete. If timeout errors do occur, in the
Deployment Wizard, click Back to return to the list of deployment tasks, and run
each of the remaining tasks individually.

Important: Do not rerun the task where the timeout occurred. The task is
complete, and running it again causes other errors.

Viewing log files
Log files for the IBM Predictive Customer Intelligence installation can be displayed
in the Deployment Wizard.

If you want to view log files directly, the log files are saved to the
/tmp/SL_####/SolutionEnabler directory.

Procedure
1. To view log files in the Deployment Wizard, select the message, and click

Detailed messages or Master log.
2. If you clicked Detailed messages, select a message, and click View Details.

Temporary file locations
Temporary files are created during the IBM Predictive Customer Intelligence
installation. You can find the location for the temporary files from the Deployment
Wizard.
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The temporary files include jar files that are used during the installation, which
you might want to delete after you complete the installation.

Procedure

In the Deployment Wizard, click Edit > Preferences.
The path to the location for the temporary files is shown in the Path box.

Modeler Server type not displaying in resource definitions
In IBM Predictive Customer Intelligence, if the Modeler Server type does not
display in resource definitions in IBM SPSS Collaboration and Deployment Services
Deployment Manager, try closing Deployment Manager and opening it again.

Error installing IBM Cognos BI
The IBM Cognos Business Intelligence installer requires a specific library file in
order to run.

If you encounter this error installing IBM Predictive Customer Intelligence, see the
IBM support page (http://www.ibm.com/support/docview.wss?uid=swg21612290)
for information on how to correct the error.
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Appendix B. Integration with the IBM Enterprise Marketing
Management suite

IBM Predictive Customer Intelligence integrates with the IBM Enterprise Marketing
Management suite. The components that Predictive Customer Intelligence
integrates with are IBM Campaign, IBM Interact and IBM Marketing Platform.

IBM Campaign
IBM Campaign is a web-based Enterprise Marketing Management (EMM)
solution that enables users to design, run, and analyze direct marketing
campaigns.

IBM Interact
With IBM Interact, users can retrieve personalized offers and customer
profile information in real-time.

IBM Marketing Platform
The IBM Marketing Platform provides security, configuration, and
dashboard features for IBM Enterprise Marketing Management products.

IBM Interact connectors
IBM Interact integrates with customer facing systems (touchpoints) such as web
sites and call centers, and enables users to retrieve personalized offers and visitor
profile information in real time.

IBM Predictive Customer Intelligence provides two connectors between IBM
Interact and IBM SPSS Collaboration and Deployment Scoring Service:
v The External callout connector calls an SPSS model at runtime, and is contained

within the expression of an advanced rule for a Marketer Score, overriding the
score supplied by the IBM Enterprise Marketing Management campaign.

v The External learning connector extends IBM Interact's native learning module
to monitor visitor actions and propose optimal offers. It prioritizes IBM
Campaign offers based on an SPSS model's prediction of their final score. The
connector passes specific configurable parameters as input to the SPSS Scoring
Service.

The External Learning connector
The External Learning connector is used to override the marketer's score in IBM
Interact with a customized score from IBM SPSS Collaboration and Deployment
Services. The customized score is used to prioritize the offers for customers. When
the customer facing touchpoint puts in an offer request to IBM Interact, it triggers
the external learning connector. A touchpoint can be a call center web application,
a mobile application, a batch command, and so on.

The following process is initiated:
1. The connector Java class calls the IBM SPSS Collaboration and Deployment

Services scoring service that is based on the configuration setting of the current
channel.

2. If, in the configuration file, the current channel is set to be monitored, the
corresponding channel in the IBM SPSS Scoring Service is configured to update
the channel offers' score number.
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3. The External Learning connector uses IBM Interact runtime session profile data
as SPSS Scoring Service input parameters.

4. The connector gets the scores from the SPSS scoring service and overwrites the
Interact offers scores with the SPSS scores.

5. After the Interact offer's score is updated by the SPSS score, the offer list is
sorted by the new final scoring number in descending order. The offer list is
returned as the final offer list.

Configuring the External Learning connector configuration file
An interactive channel is a touchpoint with your customer, such as a call center or
a website. It is the communication channel with your customers. By using the IBM
Interact API, you integrate IBM Interact with your touchpoints to present offers to
customers based on their action in the touchpoint.

Procedure
1. Stop the IBM Enterprise Marketing Management (EMM) runtime server.
2. Create the following file structure on your IBM EMM server:

For Windows operating systems:
v <EMM Interact Installation Folder>\connectors

v <EMM Interact Installation Folder>\logs

Figure 3. How the external learning connector works
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By default, the installation folder is \IBM\EMM\Interact

For Linux operating systems:
v <EMM Interact Installation Folder>/connectors/

v <EMM Interact Installation Folder>/logs

By default, the installation folder is /opt/IBM/EMM/Interact

3. Copy the LearningConnector_config.properties file and
UnicaSPSSLearningConnector.jar to the Connectors folder.

4. Edit the LearningConnector_config.properties file for your environment. For
more information, see “Sample External Learning connector configuration file.”

5. In the runtime environment for the IBM Marketing Platform tool, select
Settings, Configuration, and expand IBM EMM, Interact, and offerserving.

6. Set optimizationType to ExternalLearning.
7. Configure the External Learning class:

a. Under offerserving, select External Learning Config.
b. Set class to the Java class name. For example:

<com.ibm.unica.connector.>SPSSLearning

c. Set classPath to the Java JAR file location. For example, for Windows:
<Interact_Install_location>\UnicaSPSSLearningConnector.jar, and for
Linux: <Interact_Install_location>/UnicaSPSSLearningConnector.jar

8. Restart the IBM EMM runtime server for these changes to take effect.

Sample External Learning connector configuration file

The following example is a sample External Learning connector configuration file.
Modify this sample for your environment.
CADS_ADDRESS=<Collaboration_deployment_services_server_address>
CADS_PORT=9080
CADS_USER=admin
CADS_PASSWORD=spss
UNICA_INTERACTJSSERVICE_URL=http://<IBM_EMM_URL>:9080/
interact/servlet/InteractJSService
LEARNING_CHANNELS=Mobile,Mob;Telco,Telco Call Center;Insurance,Insurance

SERVICENAME_Telco=ExternalLearning
INPUTTABLE_Telco=db2admin@TELCO
PARAMETERS_Telco=CUSTOMERID,double,CUSTOMERID;CHURN_SCORE,double,CHURN_SCORE;
CUSTOMER_LIFE_TIME_VALUE_RATIO,double,CUSTOMER_LIFE_TIME_VALUE_RATIO;
SENTIMENT_SCORE,double,SENTIMENT_SCORE;NUMBER_OF_CLOSED_COMPLAINTS,integer,
NUMBER_OF_CLOSED_COMPLAINTS;NUMBER_OF_OPEN_COMPLAINTS,integer,
NUMBER_OF_OPEN_COMPLAINTS;GROUP_LEADER_TYPE2,double,GROUP_LEADER_TYPE2;
GROUP_LEADER_CONFIDENCE_TYPE2,DOUBLE,GROUP_LEADER_CONFIDENCE_TYPE2;
INFLUENCER_SCORE,double,INFLUENCER_SCORE;SEGMENT,string,SEGMENT;
RESPONSE,integer,#VALUE#null;OFFER_CATEGORY_NAME,string,#VALUE#null
OUTPUTNAME_Telco=FinalScore
INPUT_OFFERNAMECOL_Telco=OFFER

SERVICENAME_Insurance=INSU_CHURN
INPUTTABLE_Insurance=INSURNC.INSURANCE_VIEW
PARAMETERS_Insurance=POLICYHOLDER_ID,integer,#VALUE#1016091;GENDER,string,#VALUE#F;
EMPLOYMENT_STATUS,string,#VALUE#employed;INCOME,double,#VALUE#144541;
HOUSEHOLD_NUMBER_OF_CHILDREN,integer,#VALUE#2;HOUSEHOLD_NUMBER_OF_INSURED_CARS,integer,
#VALUE#0;NUMBER_OF_POLICIES_IN_HOUSEHOLD,integer,#VALUE#1;HOUSEHOLD_TENURE,double,
#VALUE#5.15;INSURANCE_LINES,integer,#VALUE#1;LATEST_NOTE_ATTITUDE,double,#VALUE#3;
AVERAGE_NOTE_ATTITUDE,double,#VALUE#2;NUMBER_OF_CLAIMS_FILED,double,#VALUE#2;
CUSTOMER_FINANCIAL_SEGMENT,string,#VALUE#Financially Sophisticated;
OUTPUTNAME_Insurance=CHURN_SCORE
INPUT_OFFERNAMECOL_Insurance=#NONE#
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SERVICENAME_Mobile=SequenceAnalysis
INPUTTABLE_Mobile=NBA.CUSTOMER_RELATIONSHIP_HISTORY
PARAMETERS_Mobile=CUSTOMERID,integer,CUSTOMERID;SEQUENCE,integer,#VALUE#1;
PRODUCT,string,LASTOFFER;
OUTPUTNAME_Mobile=RECOMMENDATION
INPUT_OFFERNAMECOL_Mobile=#NONE#

For information on how to modify this file, see “Add a new learning channel,” and
“Add an IBM SPSS Scoring Service to an offer (External Learning connector).”
Also, see IBM Interact Administrator's Guide.

Add a new learning channel
To add a new learning channel, add the learning name and channel name to the
LEARNING_CHANNELS parameter.

For example:

LEARNING_CHANNELS=Mobile,Mob;Telco,Telco Call Center;Insurance,Insurance

Where:
v The first value is the learning channel name (Telco), the second value is the

channel name (Telco Call Center).
v Values are separated by commas and parameters are separated by semi-colons.

Add an IBM SPSS Scoring Service to an offer (External
Learning connector)

To add an IBM SPSS Scoring Service, add the following parameters to the
LearningConnector_config.properties file.
v SERVICENAME_%THE LEARNING NAME%

v INPUTTABLE_%THE LEARNING NAME%

v PARAMETERS_%THE LEARNING NAME%

v OUTPUTNAME_%THE LEARNING NAME%

v INPUT_OFFERNAMECOL_%THE LEARNING NAME%

The parameter name has three elements that are separated by commas:
v The input parameter name.
v The data type and the source column name (profile table column name).
v The direct value that uses #VALUE# to identify it. You can also use the channel

profile table column value as SPSS input parameter values.

You can set the input parameter to null, by using #VALUE# of null, for example:

RESPONSE,integer,#VALUE#null;OFFER_CATEGORY_NAME,string,#VALUE#null

Parameters are separated by semicolons.

The value for OUTPUTNAME_%THE LEARNING NAME% can be "DEFAULT". You do not
need to provide the name of the output column name; the first output parameter is
taken as the output score results.

For example, you can set the output columns with either method that is shown,
and you get the same result:
v OUTPUTNAME_Mobile=RECOMMENDATION
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v OUTPUTNAME_Mobile=DEFAULT

The value of INPUT_OFFERNAMECOL_%THE LEARNING NAME% can be an input parameter
column name or "#NONE#". When the value is set to a specific input parameter
column name, the External Learning connector passes the IBM Interact channel
offer name to the corresponding column for the SPSS scoring service as an input
parameter to get the specific offer name score to update the corresponding offer for
Interact channel final score. When the input offer name column is set to
"#NONE#", only the first IBM Interact channel offer final score is updated with the
IBM SPSS Scoring Service score.

For example, when three offers are requested from a touchpoint, IBM Interact
returns three offers, shown in the following table.

Table 16. Example showing the scores returned from IBM Interact and from the IBM SPSS
Scoring Service

Offer name IBM Interact final score IBM SPSS score

Premium phone 90 85

Premium family plan 80 88

Add a second line free 70 65

The External Learning connector passes all of the configured parameters and the
offer name to the SPSS Scoring Service. It returns three new scores: 85, 88 and 65
from IBM SPSS for these three offers.

The IBM SPSS score is used as the final score and is sorted in descending order,
shown in the following table.

Table 17. Example showing the final score and sort order

Offer name IBM Interact final score

Premium family plan 88

Premium phone 85

Add a second line free 65

The External Callout connector
By using the External Callout connector, you can override a single offer's score by
calling an IBM SPSS Scoring Service. Also, using the External Callout connector,
you can invoke the IBM SPSS score to present eligible offers.

To enable the External Callout connector, perform the following steps:
1. Register the External Callout connector in the IBM Enterprise Marketing

Management (EMM) configuration.
2. Add the IBM SPSS Scoring Service information to the External Callout

connector's configuration file.

Configuring the External Callout connector
IBM Interact helps customers get offers based on user characteristics and history.
The offers are generated by algorithms. You can configure IBM Interact to override
the offer's score by calling an SPSS Model.
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Procedure
1. Stop the IBM Enterprise Marketing Management (EMM) runtime server.
2. Create the following file structure on your IBM EMM server:

v <EMM Interact Installation Folder>/connectors/

v <EMM Interact Installation Folder>/logs

By default, the installation folder is /opt/IBM/EMM/Interact

3. Copy the ExternalConnector_config.properties file and
UnicaSPSSExternalConnector.jar to the Connectors folder.

4. Edit the ExternalConnector_config.properties file for your environment. For
more information, see “Sample External Callout connector configuration file”
on page 79.

5. In the runtime environment for the IBM Marketing Platform, select Settings,
Configuration, and expand IBM EMM, Interact, Flowchart, and External
Callouts.

6. To set the configuration properties, click External Callout and configure the
parameters as follows:

Category name
GetSPSSscore

class com.ibm.unica.connector.GetSPSSScore

classpath

v <EMM Interact Installation Folder>/connectors/
UnicaSPSSExternalConnector.jar

By default, the installation folder is /opt/IBM/EMM/Interact

Save the changes.
7. Select the campaign settings, by clicking Campaign, Campaigns.
8. Select the link for the campaign that you are configuring, such as Insurance.
9. Click the <Campaign name> Strategy tab, for example, Insurance Strategy.

10. For each Eligible Segment, such as Insurance High Risk Customer, Insurance
High Value Customer, click Adv Opt.

11. In the Advanced Options window, select Use the following expression as the
marketing score.

12. In the Expression box, type an expression to be used for the marketing score.
You can either use modified versions of the examples shown, or from the
Functions, Variables and Operators list, select Extension Functions,
EXTERNALCALLOUT and click Use. For more information, see "About the
ExternalCallout API" topic in the IBM Interact 9.1 Administrator's Guide.
Example expression for an Insurance campaign:
NUMBER(EXTERNALCALLOUT(’GetSPSSScore’,’GetChurnScore’,db2admin.CUSTOMERID,
db2admin.GENDER,db2admin.EMPLOYMENT_STATUS,db2admin.INCOME,1,
db2admin.NUMBER_OF_INSURED_CARS,db2admin.NUMBER_OF_POLICIES_IN_HOUSEHOLD,
db2admin.HOUSEHOLD_TENURE,db2admin.INSURANCE_LINES,db2admin.LATEST_NOTE_ATTITUDE,
db2admin.AVERAGE_NOTE_ATTITUDE,db2admin.NUMBER_OF_CLAIMS_FILED,
db2admin.CUSTOMER_SEGMENTS,0))*100

The External Callout API has a mandatory number of configurable arguments
that must be provided. The mandatory number of arguments setting in the
configuration file is as set in the value of the property
ExternalConnector_NumberOfArguments. In the example shown, the value is 15.
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When there are fewer SPSS scoring service input parameters than the
configure setting of ExternalConnector_NumberOfArguments, add ",0" to the
expression to ensure that there are the same number of arguments in the
external callout expression.

13. Deploy the changes to the server.
14. Restart the IBM EMM runtime server.

Sample External Callout connector configuration file

The following example is a sample External Callout connector configuration file.
Modify this sample for your environment.
CADS_ADDRESS=<Collaboration_deployment_services_server_address>
CADS_PORT=9080
CADS_USER=admin
CADS_PASSWORD=spss
ExternalConnector_NumberOfArguments=15

SERVICENAME_GetChurnScore=INSU_CHURN
INPUTTABLE_GetChurnScore=INSURNC.INSURANCE_VIEW
PARAMETERS_GetChurnScore=POLICYHOLDER_ID,double;GENDER,string;
EMPLOYMENT_STATUS,string;INCOME,double;HOUSEHOLD_NUMBER_OF_CHILDREN,integer;
HOUSEHOLD_NUMBER_OF_INSURED_CARS,integer;NUMBER_OF_POLICIES_IN_HOUSEHOLD,integer;
HOUSEHOLD_TENURE,double;INSURANCE_LINES,integer;LATEST_NOTE_ATTITUDE,double;
AVERAGE_NOTE_ATTITUDE,double;NUMBER_OF_CLAIMS_FILED,double;
CUSTOMER_FINANCIAL_SEGMENT,string;
OUTPUTNAME_GetChurnScore=CHURN_SCORE

SERVICENAME_GetCreditRating=dWStream
INPUTTABLE_GetCreditRating=trainingdata.csv
PARAMETERS_GetCreditRating=Age,double;Income_level,string;Education,string;
Car_loans,string;
OUTPUTNAME_GetCreditRating=DEFAULT

SERVICENAME_GetReco=SequenceAnalysis
INPUTTABLE_GetReco=NBA.CUSTOMER_RELATIONSHIP_HISTORY
PARAMETERS_GetReco=CUSTOMERID,integer;SEQUENCE,integer;PRODUCT,string;
OUTPUTNAME_GetReco=RECOMMENDATION

SERVICENAME_GetCreditScore=CreditCardDefault
INPUTTABLE_GetCreditScore=NBA.CUSTOMER
PARAMETERS_GetCreditScore=CUSTOMERID,integer;AGE,integer;EDUCATION,string;
YEARSEMPLOYED,integer;INCOME,ineger;CARDDEBT,double;OTHERDEBT,double;
DEFAULTED,integer;ADDRESS,string;
OUTPUTNAME_GetCreditScore=DEFAULTPROPENSITY

For information about how to add an IBM SPSS Scoring Service to this file, see
“Add an IBM SPSS Scoring Service to an offer (External Callout connector).” Also,
see IBM Interact Administrator's Guide.

Add an IBM SPSS Scoring Service to an offer (External
Callout connector)

To add an IBM SPSS Scoring Service, add the following parameters to the
ExternalConnector_config.properties file.
v SERVICENAME_%THE EXTERNAL CONFIG NAME%

v INPUTTABLE_%THE EXTERNAL CONFIG NAME%

v PARAMETERS_%THE EXTERNAL CONFIG NAME%

v OUTPUTNAME_%THE EXTERNAL CONFIG NAME%

The parameter name has two elements that are separated by commas:
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v The input parameter name
v The data type

The parameters are separated by a semicolon.

The value for OUTPUTNAME_%THE SCORING SERVICE FUNCTION% can be "DEFAULT".
You do not need to provide the name of the output column name; the first output
parameter is taken as the output scoring results. For example, the following
methods of setting the output column get the same result:
v OUTPUTNAME_GetReco=RECOMMENDATION

v OUTPUTNAME_GetReco=DEFAULT

Troubleshooting EMM connector deployments
If you run IBM Enterprise Marketing Management version 9.0, there is an error in
the deployment section for IBM Campaign and IBM Interact. The error applies to
deploying WAR files.

About this task

Make the following configuration changes for IBM Campaign and IBM Interact
WAR files.

Procedure
1. On the server where IBM EMM is installed, go to the WebSphere Integrated

Solutions Console.
2. In the server’s Application > Enterprise Applications section, select the WAR

file that you deployed.
3. Select Class loading and update detection and set the following General

Properties on the Configuration tab:
v For Class loader order, select Classes loaded with local class loader first

(parent last).
v For WAR class loader policy, select Class loader for each WAR file in

application.
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Appendix C. Installation of the server components in silent
mode

You can install the IBM Predictive Customer Intelligence server components in
silent mode.

Editing the properties files for a silent installation of the server
components

You must edit the properties files for the silent mode installation of the IBM
Predictive Customer Intelligence server components.

Procedure
1. Go to the disk1/IBMPCI_Server/disk1 directory where you decompressed the

installation files.
2. Edit the license properties file.

a. Open the IRU_install_properties file in a text editor.
b. Add the following line after licenseType=LICR:

licenseAccepted=9

c. Save and close the file.
3. Edit the installation properties file.

a. Go to the disk1/IBMPCI_Server/disk1/taskFile directory where you
decompressed the installation files.

b. Open the properties file for the type of installation you want to run.
v For an express installation, edit Express_task.xml.
v For a custom installation, edit Custom_task.xml.

c. In the task.xml file, remove <!-- and --> surrounding the
<credentialsSet> section of the file to uncomment the section.

d. Enter the user credentials for each node computer in the userID and
password values in the <credentialsSet> section of the file.

e. Change all instances of AnalyticsNode.sample.com to the fully qualified
domain name of the Predictive Analytics node computer.

f. Change all instances of BINode.sample.com to the fully qualified domain
name of the Business Intelligence (BI) node computer.

g. Change all instances of DataNode.sample.com to the fully qualified domain
name of the data node computer.

h. Change all instances of ESBNode.sample.com to the fully qualified domain
name of the Integration Bus node computer.

i. For a custom installation, enter or confirm the remaining values in the
task.xml file.

j. Save and close the file.

Starting the silent installation
You start the IBM Predictive Customer Intelligence silent installation by running a
command.
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Procedure
1. Go to the disk1/IBMPCI_Server/disk1 directory where you downloaded the

installation files.
2. Enter the following command to install the server components:

./LinuxSetup
-responseFile /path_to_install_files/disk1/IBMPCI_Server/disk1
/IRU_install.properties
-taskFile /path_to_install_files/disk1/IBMPCI_Server/disk1/
taskFile/xxxx_task.xml -silent

Where xxxx_task.xml is task file you modified.
Log messages for the installation are saved to /opt/SolutionFiles/logs/
IRU_progress.log. If the log file contains Progress=88, that means that all of
components were successfully deployed.
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Appendix D. Use the Predictive Customer Intelligence
samples

You can install samples for the following industries: Telecommunications, Retail,
Insurance, Banking, and Energy and Utilities.

All samples except for the Banking sample contain the following components:
v IBM DB2 databases.
v IBM Analytical Decision Management templates and applications.
v IBM SPSS project streams, models, and rules.
v IBM Cognos reports and Framework Manager models and packages.

The Banking sample contains IBM DB2 databases and an IBM SPSS project stream.
It does not contain IBM Analytical Decision Management templates and
applications or IBM Cognos reports and Framework Manager packages. Therefore,
you do not need to install the Analytical Decision Management templates and
applications or the IBM Cognos Content if you are using this sample.

The Telecommunications, and Energy and Utilities samples contain report images
that must be installed.

To install the samples, you must perform the following steps for each sample that
you are using.
1. Run the Deployment wizard to deploy the samples on a computer with a

Microsoft Windows operating system installed.
2. Create the sample databases on the Data node.
3. Install the Analytical Decision Management templates and applications on the

Predictive Analytics node.
4. Import the SPSS project streams, models, and rules on the Predictive Analytics

node.
5. Configure the data view for SPSS models on the Predictive Analytics node.
6. Install the IBM Cognos Content on the Business Intelligence node.

Important: There are no touchpoints included with the samples. For example, no
call center applications or web sites are included.

Sample prerequisites
Before you install the samples, you must have a fully configured environment.

You must have administration rights and have the ability to copy files between
servers and platforms.

The IBM Predictive Customer Intelligence Sample Deployment Wizard must be run
on a computer that is running a Microsoft Windows operating system.

The steps to install each sample must be completed in the order shown.
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Installing the samples
The IBM Predictive Customer Intelligence Sample Deployment Wizard copies the
samples to your computer. You must configure each sample individually after it is
copied to your computer.

Use the Predictive Customer Intelligence Sample Deployment Wizard on a
computer that is running a Microsoft Windows operating system.

Procedure
1. Go to the directory where you downloaded the samples installation files.
2. Decompress the installation files.
3. Double-click Launchpad.exe or Launchpad64.exe.
4. Follow the steps in the wizard to copy the samples.

The Deployment wizard prompts you for the location to copy the samples. If
you select the default, the samples are copied to c:\IBM\PCIsamples\
sample_name.

5. Click Deploy All.

Creating the sample databases
The IBM Predictive Customer Intelligence samples include sample databases. You
must run a script to create a database, and then run another to populate the
databases for each sample that you are using.

Procedure
1. Log on to the data node computer as root user.
2. Create a folder on the data node computer to contain the samples. For example,

/opt/IBM/PCI.
3. Copy the samples files from the computer where you installed them to the data

node computer:
v The Telecommunications sample is in Telco\Database\

IBM_PCI_Telco_Data.zip.
v The Retail sample is in Retail\Database\IBM_PCI_Retail_Data.zip.
v The Insurance sample is in Insurance\Database\IBM_PCI_Insurance_Data.zip

v The Banking sample is in Banking\Database\IBM_PCI_Banking_Data.zip.
v The Energy and Utilities sample is in Energy and Utilities\Database\

IBM_EU_Data.zip.
4. On the data node computer, decompress the files.
5. Open a terminal window, and go to the directory where you decompressed the

sample files.
6. Type the following command to change the permissions for the files:

chmod -R 755 *

7. Change to the database instance owner. For example, su db2inst1.
8. In the uncompressed directory, run sh ./Install_DB.sh to create the database.

Note: For the Energy and Utilities sample, two databases are created: EUTIL
and PCI_UTIL.

9. Run sh ./Load_Data.sh to populate the database.
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What to do next

Verify that the tables are created and the data is successfully loaded into the input
tables by checking the out.log file.

The log file is in the db2inst1 home directory.

Search for “rows were rejected” in the log file. The value should be zero, if it is
not, there are data load issues.

Installing Analytical Decision Management templates and applications
The following Predictive Customer Intelligence samples include IBM Analytical
Decision Management templates and applications: Telecommunications, Retail,
Insurance, and Energy and Utilities. The Banking sample does not include IBM
Analytical Decision Management templates and applications.

Procedure
1. Log on to the Predictive Analytics node computer.
2. From the computer where you deployed the samples, copy the Analytical

Decision Management applications and templates for the samples that you are
using from the following locations:
v Telecommunications

– Application: Telco\Analytics\Applications\IBM_PCI_Telco_App.zip
– Template: Telco\Analytics\Templates\TelcoCallCenter.xml

v Retail
– Application: Retail\Analytics\Applications\IBM_PCI_Retail_App.zip
– Template: Retail\Analytics\Templates\Retail.xml

v Insurance
– Application: Insurance\Analytics\Applications\

IBM_PCI_Insurance_App.zip

– Template: Insurance\Analytics\Templates\Insurance.xml
v Energy and Utilities

– Application: Energy and Utilities\Analytics\Applications\
IBM_PCI_Energy _and_Utilities_App.zip

– Template: Energy and Utilities\Analytics\Templates\Energy and
Utilities.xml

Copy files to the Applications or Templates folder as appropriate on the
Predictive Analytics node computer.
The default location is /opt/IBM/SPSS/Collaboration and Deployment
Services/6.0/Server/components/decision-management/Applications,
or/Templates.

3. Decompress the files to the Applications directory.
4. In a browser, go to the IBM Analytical Decision Management launch page:

http://SPSS server name:port number/DM

5. Click Add Application, and select the appropriate application. For example,
Telco Call Center.
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Importing project streams, models, and rules
Project streams, models, rules and other artifacts are contained in a repository
export file for each sample. Copy the export file to the Predictive Analytic node
where IBM SPSS Collaboration and Deployment Manager is installed.

Procedure
1. Log on to the Predictive Analytics node computer using an administrator

account.
2. From the computer where you deployed the samples, copy the

IBM_PCI_sample_name.pes file to the Predictive Analytics node computer. For
example, copy the file to a /opt/IBM/PCI directory.
The files are located in the following folders:
v Telecommunications: \Telco\Analytics\IBM_PCI_Telco.pes
v Retail: Retail\Analytics\IBM_PCI_Retail.pes
v Insurance: Insurance\Analytics\IBM_PCI_Insurance.pes
v Banking: Banking\Analytics\IBM_PCI_Banking.pes
v Energy and Utilities: Energy and Utilities\Analytics\IBM_PCI_EU.pes

3. In IBM SPSS Collaboration and Deployment Manager, import the
IBM_PCI_sample_name.pes file with the following settings selected:
v Resolve conflicts globally

v Add new version of target item or rename source item, Use labels from
source.

v Continue import even if some objects cannot be imported due to locking
conflicts.

v Resolve Invalid Version Conflicts, Import.
v Resource Definitions, Recommended. Import if there are no duplicate ID

conflicts or duplicate name conflicts.

Results

Content folders and resource definitions are added to the repository alongside any
existing content.

Configuring the data view for SPSS models
To configure the data view, IBM SPSS Modeler must be connected to the samples
databases through an ODBC data source. You must perform extra steps for the
Insurance and Retail samples.

About this task

If your IBM Predictive Customer Intelligence environment uses the IBM SPSS
Modeler client logged in to a Modeler server, perform the steps on the Predictive
Analytics node computer (where IBM SPSS Modeler Server is installed).

If your Predictive Customer Intelligence environment uses the IBM SPSS Modeler
Client in a stand-alone environment, perform the steps on the client computer
where IBM SPSS Modeler client is installed.

Procedure
1. Catalog the database on the client computer.
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a. Click Start > IBM DB2 > DB2COPY1 (Default) > DB2 Command Window
- Administrator.

b. Enter the following command to catalog the database node:
db2 catalog tcpip node NODE_NAME remote data_node_name server PORT_NUMBER

NODE_NAME can be any value. PORT_NUMBER is 50000 by default.
c. Enter the following command to catalog the PCI database:

db2 catalog database DATABASE_NAME at node NODE_NAME authentication server

Where the Database_names are as shown in the following table:

Table 18. Sample DSN names and database names

Sample DSN and database names

Telecommunications TELCO

Retail RETAIL

Insurance INSURNC

Banking BANKING

You must use the same node_name that you used in the db2 catalog
database command.

2. Create an ODBC DSN to point to each sample database listed in the table. The
database account that is provided in the ODBC connection must be the same
user that was used for creating tables.

Tip: On a computer with Microsoft Windows installed, in the Windows Control
Panel, select Administrative Tools and click Data Sources. Click the System
DSN tab.

The following steps are for the Retail and Insurance samples only.

These samples use the Analytic Data View and JDBC source connections for
accessing IBM Analytical Decision Manager. When the Retail or Insurance samples
are imported through IBM SPSS Collaboration and Deployment Services
Deployment Manager, a new version of the Enterprise View is created that contains
only the tables that are related to the samples.
3. In the Deployment Manager client, under Resource Definitions, Credentials,

open the db2admin credentials and update the user ID and password to the
DB2 administrator account of the Data node.

4. In Resource Definitions, Data Sources, open the data source for the sample,
either RETAIL_JDBC, or INSURANCE_JDBC, and update the IP address and
port to point to the IBM Predictive Customer Intelligence Data node. The
default DB2 port is 50000.

5. Open the data source, either RETAIL_ODBC, or INSURANCE_ODBC, and
verify that the data source name corresponds to the ODBC name created for the
sample database.

6. Verify that the Application View and the Data Provider Definition are working
properly. Open the RETAIL_CUSTOMER_ATTRIBUTES_DPD, or
INSURANCE_DPD, and click Validate. To retrieve a previous version of the
Enterprise View, right-click Enterprise View in Deployment Manager and click
Open Version.

7. To create a single view that combines the solution tables with any tables that
existed previously, right-click Enterprise View in Deployment Manager and
click Merge Versions.
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Configuring ODBC for IBM SPSS Modeler Server on Linux
To use an ODBC data source in a Linux with IBM SPSS Modeler Server, you must
configure the environment.

Procedure
1. Stop the IBM SPSS Modeler Server.
2. Download the relevant compressed archive for IBM SPSS Modeler Server

installed. This driver is part of IBM Predictive Customer Intelligence Server
deployment.

3. Extract the archive.
4. Run the setodbcpath.sh script to update the ODBC path in the scripts.
5. Edit the odbc.sh script to add the definition for ODBCINI to the bottom of the

script. For example:
ODBCINI=/usr/spss/odbc/odbc.ini; export ODBCINI

ODBCINI must point to the full file path of the odbc.ini file for IBM SPSS
Modeler. The odbc.ini file lists the ODBC data sources that you want to
connect to. A default odbc.ini file is installed with the drivers.

6. This step is for the 64-bit version of IBM SPSS Modeler Server only. Define
and export LD_LIBRARY_PATH_64 in the odbc.sh script:
if [ "$LD_LIBRARY_PATH_64" = "" ]; then
LD_LIBRARY_PATH_64=<library_path>
else
LD_LIBRARY_PATH_64=<library_path>:$LD_LIBRARY_PATH_64
fi
export LD_LIBRARY_PATH_64

Where <library_path> is the same as for the LD_LIBRARY_PATH definition in the
script that was initialized with the installation path. For example,
/usr/spss/odbc/lib.

Tip: You can copy the if and export statements for LD_LIBRARY_PATH in the
odbc.sh file, append them to the end of the file. Then, replace the
LD_LIBRARY_PATH strings in the newly appended if and export statements
with LD_LIBRARY_PATH_64. Here is an example of the odbc.sh file for a 64-bit
IBM SPSS Modeler Server installation:
if [ "$LD_LIBRARY_PATH" = "" ]; then

LD_LIBRARY_PATH=/usr/spss/odbc/lib
else

LD_LIBRARY_PATH=/usr/spss/odbc/lib:$LD_LIBRARY_PATH
fi
export LD_LIBRARY_PATH
if [ "$LD_LIBRARY_PATH_64" = "" ]; then

LD_LIBRARY_PATH_64=/usr/spss/odbc/lib
else

LD_LIBRARY_PATH_64=/usr/spss/odbc/lib:$LD_LIBRARY_PATH_64
fi
export LD_LIBRARY_PATH_64
ODBCINI=/usr/spss/odbc/odbc.ini; export ODBCINI

Ensure that you export LD_LIBRARY_PATH_64, and define it with the if loop.
7. Configure IBM SPSS Modeler Server to use the driver. Edit modelersrv.sh and

add the following line immediately below the line that defines SCLEMDNAME:
. <odbc.sh_path>

Where odbc.sh_path is the full path to the odbc.sh file.
For example: . /usr/spss/odbc/odbc.sh

Ensure that you leave a space between the first period and the file path.
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8. Save modelersrv.sh.
9. Configure the SPSS Modeler Server to use the ODBC wrapper named

libspssodbc_datadirect.so.
a. Navigate to the SPSS Modeler Server Installation directory/bin folder.
b. Remove the existing link file named libspssodbc.so by using the

following command:
rm –fr libspssodbc.so

c. Link the new wrapper to libspssodbc.so by using the following
command:
ln –s libspssodbc_datadirect_utf16.so libspssodbc.so

10. Configure the db2cli.ini file in <db2 instance home>/sqllib/cfg/db2cli.ini
to add the following lines to define a DB2 client alias for your database:
[Data Source Name]
Database=DB name
Protocol=TCPIP
DriverUnicodeType=1
Port=50000
Hostname=ip or hostname
UID=username
PWD=password

11. In the odbc.ini file, create a new ODBC data source for the DB2 database. The
data source name must be the same as specified for the DB2 client alias. Also,
specify DriverUnicodeType=1 to avoid buffer overflow errors when connecting
to the database.
For example:
Data Source Name = DB2 ODBC Driver

[Data Source Name]
Driver=/opt/ibm/db2/V10.1/lib64/libdb2o.so
DriverUnicode=1
Database=TELCO
Hostname=<host name>
Port=50000
Protocol=TCPIP

Note: You must use the driver library libdb2o.so with IBM SPSS Modeler.
12. Save odbc.ini.

What to do next

To test the connection, do the following steps:
1. Restart IBM SPSS Modeler Server.
2. Connect to IBM SPSS Modeler Server from a client.
3. Add a database source node to the canvas.
4. Open the node and verify that you can see the data source names that you

defined in the odbc.ini file.

If you are unable to connect to the data source, see IBM SPSS Modeler Server 16
Administration and Performance Guide Appendix B for more information.
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Installing IBM Cognos content
The following IBM Predictive Customer Intelligence samples include IBM Cognos
content: Telecommunications, Retail, Insurance, and Energy and Utilities.

Perform these tasks for each sample that you are using.

There is no IBM Cognos content for the Banking sample.

Procedure
1. Copy the IBM Cognos content from the computer where you installed it to the

locations specified in the following table.

Table 19. IBM Cognos content

Cognos content Copy to

Cognos deployment package:\
<sample_name>\Business Intelligence\IBM
PCI<sample_name> Cognos Content

Business Intelligence node, in the folder
<Cognos_Install_location>\Deployment

Cognos report images: \<sample_name>\
Business Intelligence\IBM
PCI<sample_name> IBM PCI <sample_name>
Report Images
Note: This is for the Telecommunications
and Energy and Utilities sample only. The
Retail, Insurance, and Banking samples do
not include report images.

Business Intelligence node, in the folder
<Cognos_Install_location>\webcontent\
samples

Decompress the files to the following
folders:

For Telecommunications
<Cognos_Install_location>\
webcontent\samples\images\Telco

For Energy and Utilities
<Cognos_Install_location>\
webcontent\samples\images\EU

Tip: To decompress a file on a computer
with a Linux operating system installed,
type "unzip <"zip file name">". The zip
file name must be enclosed by quotation
marks because it contains spaces.

Cognos Framework Manager packages:
\<sample_name>\Business Intelligence\IBM
PCI<sample_name> IBM PCI <sample_name>
Model

The Windows computer where Framework
Manager is installed.

Decompress the files.

2. Catalog the database on the client computer.
a. Click Start > IBM DB2 > DB2COPY1 (Default) > DB2 Command

Window - Administrator.
b. Enter the following command to catalog the database node:

db2 catalog tcpip node NODE_NAME remote data_node_name server PORT_NUMBER

NODE_NAME can be any value. PORT_NUMBER is 50000 by default.
c. Enter the following command to catalog the PCI database:

db2 catalog database DATABASE_NAME at node NODE_NAME authentication server

Where the Database_names are as shown in the following table:

Table 20. Sample DSN names and database names

Sample Database names

Telecommunications TELCO
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Table 20. Sample DSN names and database names (continued)

Sample Database names

Retail RETAIL

Insurance INSURNC

Energy and Utilities EUTIL

PCI_UTIL

You must use the same node_name that you used in the db2 catalog
database command.

Configure IBM Cognos to point to the new databases.
3. Open a web browser.
4. Go to the IBM Cognos BI portal URL. For example, go to

http://bi_node_name/ibmcognos/.
5. On the Welcome page, click Administer IBM Cognos Content.
6. Create a data source connection to the samples database. This step must be

done twice for Energy and Utilities, once for each database in the sample, and
once for each of the other industry samples.
a. Click the Configuration tab, and click Data Source Connections.

b. Click the New Data Source button.
c. In the Name box, type the sample database name, for example TELCO and

then click Next.
d. In the connection page, select IBM DB2, ensure that Configure JDBC

connection is selected, and click Next.
The connection string page for the selected database appears.

e. In the DB2 database name field, type the sample database name. For
example TELCO.

f. Leave DB2 connect string blank.
g. Under Signons, select both Password and Create a signon that the

Everyone group can use, type the user ID and password for the DB2
instance owner user that you used to create the database, and click Next.

Tip: To test whether the parameters are correct, click Test the connection.
After you test the connection, click OK to return to the connection page.

h. In the Server name box, enter the name or IP address of your data node
computer.

i. In the Port number box, enter the DB2 port number. The default is 50000.
j. In Database name, type the sample database name. For example TELCO.

Tip: To test whether the parameters are correct, click Test the connection.
After you test the connection, click OK to return to the connection page.

k. Click Finish.

Import the Cognos content for the sample.
7. Deploy the IBM Cognos BI reports.

a. On the Configuration tab, click Content Administration.
b. On the toolbar, click the New Import button.
c. In the Deployment Archive pane, select IBM PCI < Sample_name>

Content, and click Next.
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d. In the Public Folders Content pane, select IBM PCI < Sample_name>,
leave the Options as default, and click Next.

e. In the Specify the general options pane, accept the defaults, and click
Next.

f. On the Review the summary page, click Next.
g. On the Select an action page, select Save and run once, and click Finish.
h. On the Run with options page, accept the defaults, and click Run, and

then click OK.
i. Select View the details of this import after closing this dialog and click

OK. The next screen displays the status of the import. After a few second,
click Refresh and ensure that the status is "Succeeded".

j. In IBM Cognos Administration, click the Home button.

For the Retail sample only, install the portal pages
8. In IBM Cognos Connections, click the Public Folders tab.
9. Click IBM PCI Retail Portal Pages.

10. For each of the reports, click .

What to do next

You can use the following test customer IDs for samples where a Customer ID is
required. When you run some reports, you are prompted for a customer ID.
v For the Telecommunications, and Energy and Utilities sample, type 21.
v For the Insurance sample, use the following inputs for the specified report:

– CaseReportInsurance, Churn and Sentiment Scores, Churn Propensity,
ClaimsReport, and PolicyDetails: 1001920.

– SMA Insight: AaronBBailey@trashymail.com
– Social and Web Analytics: 1006598

Sample reports and portal pages
A number of Predictive Customer Intelligence reports and portal pages can be
installed with the samples.

The following industry samples include reports: Telecommunications, Retail,
Insurance, and Energy and Utilities. The Banking sample does not include reports.

You can customize the reports and portal pages using IBM Cognos Report Studio.
Cognos Report Studio is a report design and authoring tool. Report authors can
use Report Studio to create, edit, and distribute a wide range of professional
reports. For more information see IBM Cognos Report Studio User Guide
(http://www.ibm.com/support/knowledgecenter/SSEP7J_10.2.1/
com.ibm.swg.ba.cognos.ug_cr_rptstd.10.2.1.doc/c_rs_introduction.html).

The metadata that the report displays comes from the package that is created in
IBM Cognos Framework Manager. The example Framework Manager project folder
contains the compiled project file (.cpf). When you open the .cpf file, Framework
Manager displays the modeled relationships of the data and the package
definitions, which are made available to the reporting studios when published. You
can modify the metadata for the report by using Framework Manager. For more
information, see IBM Cognos Framework Manager User Guide
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(http://www-01.ibm.com/support/knowledgecenter/SSEP7J_10.2.1/
com.ibm.swg.ba.cognos.ug_fm.10.2.1.doc/c_ug_fm_introduction.html
%23ug_fm_Introduction).

Reports available in the Telecommunications, and Energy and
Utilities samples

The following Predictive Customer Intelligence reports are available from the home
page for the Telecommunications, and Energy and Utilities samples.

BillingReports
The Billing report displays the customer billing history, calculated bill
amount, and potential savings.

CaseDetailReports
The CaseReport shows the open and closed case history of the customer: a
bar chart that plots the case status per month, a list with detail case
information and a list that shows social media posts.

NetworkReports
The StoresMapReport shows the location of nearest stores for a specified
location, in a map report.

ProfileReports
The Dials report shows the analytics key performance indicators (KPIs) for
a customer.

For the Telecommunications sample only, the SocialNetworkChart report
shows the social network chart for a customer ID.

UsageReports
The Usage report shows the voice and data usage of the customer.

Portal pages available in the Retail sample

The following Predictive Customer Intelligence portal pages are available from the
home page for the Retail sample.

Customer Online Activity Analysis
Shows detailed analysis of the customer's online activities with the
following charts:
v Purchase Activity Analysis (Traditional) shows a distribution of purchase

activities across different product lines.
v All Online Activity Analysis shows a relative comparison of all online

activities for all product lines.
v Relative Activity Conversion Analysis shows a stacked chart to analyze

the conversions between different online activities, such as Page Views,
Products Browsed, Products Carted, Products Abandoned, Products
Purchased, for all product lines.

v Analyzing Online Activities by Customer Segments allows you to
analyze the online activities for different customer segments and
combinations of customer segments.

v Analyzing Online Activities for Demographic Cluster shows a detailed
analysis of online activities for a demographic cluster. For example, for a
selected product line which cluster has highest products browsed
activity.

Customer Response Analysis
Contains two charts that are based on the data available from a customer’s
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response to product satisfaction and various offers that were made through
the IBM Analytical Decision Management application.

Contains a dial chart that shows how the customers rated a particular
product line or a product. It also contains a column chart that shows the
relative comparison of the probability of accepting different offers.

Market Basket Analysis
Shows the products that are likely to be bought together. This report can
also be filtered for individual products.

Understanding the Customer
Shows a distribution of a customer’s online activities across different
product lines, and customer segmentation. Customer segments are shown
by using a customer’s demographic data, online activity data, and their
purchasing behavior.

Reports available in the Insurance sample

The following Predictive Customer Intelligence reports are available from the home
page for the Insurance sample.

CaseReportInsurance
Shows the cases by month for the selected client.

Churn and Sentiment Scores
The Dial report shows churn propensity and sentiment score.

Churn Propensity
Shows the churn propensity ratio (the willingness of the client to leave the
provider) for the selected client.

ClaimsReport
The list report shows customer claims information.

Complaints
The bar chart and list report shows customer complaints information.

PolicyDetails
The list report shows customer policy information.

SMA Insight
Shows the social media activity for the selected client.

Social and Web Analytics
The pie chart and list report show customer social media post and
insurance product browsing summary information.

Copying the samples license files to each computer
After you install the samples, you must copy the swidtag file and license
directory to each computer on which you use an IBM Predictive Customer
Intelligence sample.

Important: Do not rename the directories or files.

Procedure
1. Copy the swidtag file from the iso-swid directory where you installed the

samples to each computer on which you install a Predictive Customer
Intelligence component.
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For example, copy the file so that you have an /opt/IBM/PCI/iso-swid
directory that contains a swidtag file on each node computer. And a
C:\IBM\PCI\iso-swid directory that contains a swidtag file on each client
computer.
If a iso-swid directory already exists on the computer, do not overwrite the
directory. Add the swidtag file to the existing directory.
After you copy the IBM Predictive Customer Intelligence sample software tag
file, your iso-swid directory should have two swidtag files. One swidtag file is
for the product and the other swidtag file is for the samples.

2. Copy the license directory from the directory where you installed the samples
to each computer on which a IBM Predictive Customer Intelligence component
is installed.
For example, copy the directory and contents so that you have an
/opt/IBM/PCIsamples/license directory that contains the license files on each
node computer. And a C:\IBM\PCIsamples\license directory that contains the
license files on each client computer.

Results

After you install the samples, the following folders must exist on each computer
on which you installed a Predictive Customer Intelligence component:
v On server computers:

/opt/IBM/PCI/license (containing the product license files)
/opt/IBM/PCIsamples/license (containing the samples license files)
/opt/IBM/PCI/iso-swid (containing a product swidtag file and a samples
swidtag file)

v On client computers:
C:\IBM\PCI\license (containing the product license files)
C:\IBM\PCIsamples\license (containing the samples license files)
C:\IBM\PCI\iso-swid (containing a product swidtag file and a samples swidtag
file)
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Appendix E. Products installed with IBM Predictive Customer
Intelligence

The following products are installed with or available to be installed with
Predictive Customer Intelligence.

Server components
v IBM DB2 Enterprise Server Edition 10.1 Fix Pack 3
v IBM Data Server Runtime Client 10.1 Fix Pack 3
v IBM WebSphere Application Server Network Deployment 8.5.5
v IBM Installation Manager 1.6.2
v IBM Cognos Business Intelligence Server 10.2.1 Fix Pack 1
v IBM Integration Bus 9.0 Fix Pack 1
v IBM WebSphere MQ 7.5 Fix Pack 2
v IBM SPSS Collaboration and Deployment Services Server 6.0
v IBM SPSS Collaboration and Deployment Services 6.0 Deployment Manager
v IBM SPSS Collaboration and Deployment Services Enterprise View Driver 6.0
v IBM SPSS Modeler Server 64-bit 16.0
v IBM SPSS Data Access Pack 7.1
v IBM SPSS Text Analytics Server 16.0
v IBM SPSS Modeler Collaboration and Deployment Services Adapter 16.0
v IBM SPSS Analytical Decision Management 8.0
v IBM SPSS Statistics Server 22.0
v IBM SPSS Statistics 22.0 Collaboration and Deployment Services Adapter 6.0
v IBM SPSS Modeler Solution Publisher 16.0
v IBM SPSS Modeler Premium Solution Publisher 16.0

Client and optional components

In the Predictive Customer Intelligence license, these components are referred as
“Supporting Programs - Client Installation”.
v IBM Data Server Runtime Client 10.1 Fix Pack 3
v IBM Cognos Framework Manager 10.2.1
v IBM Cognos Business Intelligence Samples 10.2.1
v IBM Cognos Supplementary Languages Documentation 10.2.1
v IBM Cognos Dynamic Query Analyzer 10.2.1
v IBM Cognos for Microsoft Office 10.2.0
v IBM Cognos Lifecycle Manager 10.2.1
v IBM Cognos Mobile 10.2.1 Fix Pack 2
v IBM Cognos Real-time Monitoring 10.2.1 Fix Pack 1
v IBM Cognos Software Development Kit 10.2.1
v IBM SPSS Collaboration and Deployment Services Deployment Manager 6.0
v IBM SPSS Modeler Client 16.0
v IBM SPSS Text Analytics Client 16.0
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v IBM SPSS Data Access Pack 7.1
v IBM SPSS Social Network Analysis 16.0
v IBM SPSS Statistics Client 22.0
v IBM Integration Bus Toolkit 9.0.0.1
v IBM Installation Manager 1.6.2
v IBM WebSphere MQ Client 7.5 Fix Pack 2
v IBM SPSS Concurrent Licensing Tools 9.5.0.1
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Appendix F. Programs not authorized by the IBM Predictive
Customer Intelligence license

The following programs are not installed with IBM Predictive Customer
Intelligence, and the use of these programs is not authorized by the Predictive
Customer Intelligence license.
v IBM Cognos Analysis for Microsoft Excel (IBM Cognos Business Intelligence

Architect 10.2.1)
v IBM Cognos Analysis Studio (of IBM Cognos Business Intelligence Architect

10.2.1)
v IBM Cognos Business Intelligence Transformer (of IBM Cognos Business

Intelligence Architect 10.2.1)
v IBM Cognos Connection Installer for IBM Cognos Insight (of IBM Cognos

Business Intelligence Architect 10.2.1)
v IBM Cognos Cube Designer (of IBM Cognos Business Intelligence Architect

10.2.1)
v IBM Cognos Data Manager Connector (of IBM Cognos Business Intelligence

Architect 10.2.1)
v IBM Cognos Insight (of IBM Cognos Business Intelligence Architect 10.2.1)
v IBM Cognos Metric Designer (of IBM Cognos Business Intelligence Architect

10.2.1)
v IBM Cognos Metric Studio (of IBM Cognos Business Intelligence Architect 10.2.1)
v IBM Cognos Metrics Manager (of IBM Cognos Business Intelligence Architect

10.2.1)
v IBM Cognos Migration Tools (of IBM Cognos Business Intelligence Architect

10.2.1)
v IBM Cognos PowerPlay® Client (of IBM Cognos Business Intelligence Architect

10.2.1)
v IBM Cognos PowerPlay Server (of IBM Cognos Business Intelligence Architect

10.2.1)
v IBM Cognos PowerPlay Studio (of IBM Cognos Business Intelligence Architect

10.2.1)
v IBM Cognos Query Studio (of IBM Cognos Business Intelligence Architect 10.2.1)
v IBM Cognos TM1® Package Connector (of IBM Cognos Business Intelligence

Architect 10.2.1)
v IBM Connections (of IBM Cognos Business Intelligence Architect 10.2.1)
v IBM DB2 Workgroup Server Edition (of IBM Cognos Business Intelligence

Architect 10.2.1, IBM Cognos Real-time Monitoring 10.2.1)
v IBM Tivoli® Directory Integrator Identity Edition (of IBM Cognos Business

Intelligence Architect 10.2.1)
v IBM SPSS Data Collection Survey Reporter Developer Kit 7.x (of IBM SPSS

Modeler Premium 16.0, IBM SPSS Modeler Server Premium 16.0, IBM SPSS
Statistics Standard 22.0, IBM SPSS Statistics Server Standard 22.0)

v IBM SPSS Modeler Client Entity Analytics (of IBM SPSS Modeler Premium 16.0)
v IBM SPSS Modeler Server Entity Analytics (of IBM SPSS Modeler Server

Premium 16.0)
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v BM SPSS Data Collection Developer Library 7.x (of IBM SPSS Statistics Standard
22.0, IBM SPSS Statistics Server Standard 22.0)

v IBM SPSS Statistics Data File Drivers 22.x (IBM SPSS Statistics Server Standard
22.0)

v IBM SPSS Statistics Diagnostic Utility 22.x (of IBM SPSS Statistics Standard 22.0)
v IBM SPSS Statistics-.Net Integration Plug-In 22.x (of IBM SPSS Statistics Standard

22.0, IBM SPSS Statistics Server Standard 22.0)
v IBM DB2 Workgroup Server Edition 10.5 (IBM DB2) (of IBM SPSS Modeler

Premium 16.0, IBM SPSS Modeler Server Premium 16.0)
v IBM WebSphere Application Server Developer Tools for Eclipse (of IBM

WebSphere Application Server Network Deployment 8.5.5)
v IBM WebSphere eXtreme Scale (of IBM WebSphere Application Server Network

Deployment 8.5.5)
v IBM Rational® Application Developer for WebSphere Software (of WebSphere

Application Server Network Deployment 8.5.5)
v J2SE Rule Execution Server (of IBM Integration Bus 9.0)
v IBM Data Studio 3.2 (of IBM DB2 Enterprise Server Edition 10.1)
v IBM WebSphere MQ 7.1 (of IBM DB2 Enterprise Server Edition 10.1)
v pureScale® Feature (of IBM DB2 Enterprise Server Edition 10.1)
v IBM General Parallel File System (GPFS™) for AIX® 3.5 (of IBM DB2 Enterprise

Server Edition 10.1)
v IBM General Parallel File System (GPFS) for Linux Multiplatform 3.5 (of IBM

DB2 Enterprise Server Edition 10.1)
v IBM Mobile Database 7.0.1 (of IBM DB2 Enterprise Server Edition 10.1)
v IBM Mobile Database Sync 1.0 (of IBM DB2 Enterprise Server Edition 10.1)
v IBM Tivoli Storage Flashcopy Manager 2.2 (of IBM DB2 Enterprise Server

Edition 10.1)
v Embedded version of IBM WebSphere Application Server ("embedded

WebSphere Application Server") 6.1 (of IBM Tivoli System Automation for
Multiplatforms 3.2 (of IBM DB2 Enterprise Server Edition 10.1))

v IBM Cloudscape 10 (of IBM Tivoli System Automation for Multiplatforms 3.2 (of
IBM DB2 Enterprise Server Edition 10.1))

v Embedded WebSphere Application Server 7.0 (of IBM Tivoli Directory Server 6.3
- Client Only (component) (of IBM DB2 Enterprise Server Edition 10.1)

v IBM InfoSphere® Change Data Capture 6.2 (of IBM InfoSphere Data Replication
10.1 (component) (of IBM DB2 Enterprise Server Edition 10.1))

v IBM InfoSphere Change Data Capture 6.5 (of IBM InfoSphere Data Replication
10.1 (component) (of IBM DB2 Enterprise Server Edition 10.1))

v IBM InfoSphere Replication Server 9.7 (of IBM InfoSphere Data Replication 10.1
(component) (of IBM DB2 Enterprise Server Edition 10.1))

v IBM Tivoli Directory Integrator 7.1 (of IBM Tivoli Directory Server 6.3 - Client
Only (component) (of IBM DB2 Enterprise Server Edition 10.1))

v WebSphere Application Server 7.0 (of IBM Tivoli Directory Server 6.3 - Client
Only (component) (of IBM DB2 Enterprise Server Edition 10.1))

v IBM DB2 Workgroup Server Edition 9.7 (of IBM Tivoli Directory Server 6.3 -
Client Only (component) (of IBM DB2 Enterprise Server Edition 10.1))

v IBM DB2 Enterprise Server Edition 9.7 (of IBM Tivoli Directory Server 6.3 -
Client Only (component) (of IBM DB2 Enterprise Server Edition 10.1))

100 IBM Predictive Customer Intelligence Version 1.0.0: Installation Guide for Linux Operating Systems



v IBM InfoSphere Data Replication 10.1 (component) (of IBM InfoSphere
Federation Server 10.1 (component) (of IBM DB2 Enterprise Server Edition 10.1))

v IBM WebSphere MQ 7.1 (of IBM InfoSphere Federation Server 10.1 (component)
(of IBM DB2 Enterprise Server Edition 10.1))

v IBM DB2 Connect™ 10.1, Application Server Edition (of IBM InfoSphere
Federation Server 10.1 (component) (of IBM DB2 Enterprise Server Edition 10.1))
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Appendix G. Performance tuning for IBM Predictive Customer
Intelligence

The topics in this appendix provide examples of configuration changes that might
help improve performance of your Predictive Customer Intelligence installation.

Tune WebSphere Application Server for Predictive Customer
Intelligence

Performance tuning settings for WebSphere Application Server include JVM tuning,
thread pools, connection pools, web container settings, logging, and web server
monitoring.

JVM tuning
Setting an appropriate Java virtual machine (JVM) heap size can improve
performance for IBM Predictive Customer Intelligence. Also, garbage collection is
an integral Java runtime service. Increasing the JVM heap size can reduce the
number of garbage collection occurrences and provide a 10 percent gain in
performance.

Heap size

The heap size should be set to an optimal value. It should not exceed 80% of the
physical memory available on the computer. Doing so would enable paging and
increase processor usage, which affects the performance of WebSphere Application
Server.

For Predictive Customer Intelligence, use 4096 MB.

The Max Heap Size is the maximum heap size that would be allocated to the
server. It is important that the value is less than the available physical memory.

For Predictive Customer Intelligence, use 7128 MB.

Garbage collection

Parallel garbage collection is a technique that uses several dedicated threads for
garbage collection. This method improves garbage collection pause time, which
increases processor efficiency and improves performance.

This process can be activated by setting the –Xgcthreads value to the number of
processors on the computer. For example, set –Xgcthreads:number_of_processors,
However, this method is not entirely suited for concurrent users.

For concurrent users, use -Xgcpolicy:optavgpause.

Thread pools
Thread pools enable server components to reuse threads. Reusing threads
eliminates the need to create new threads at run time, and creating new threads
expends time and resources.
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Web container thread pool

The web container thread pool is used for HTTP requests that come from the
client. Set the number of threads to double the number of users that might be
expected to access the application concurrently.

For example, for IBM Predictive Customer Intelligence, set the minimum value to
3000 and the maximum to 5000.

Connection pools

Connection pools are associated with data source configuration for web
applications, and it is used to direct JDBC calls within the application.

When a user makes a request over the web to a resource, the resource accesses the
data source. Because users connect and disconnect frequently with applications on
the internet, the application requests for data access can surge to considerable
volume. Consequently, the total data store overhead quickly becomes high for
web-based applications, and performance deteriorates. However, when connection
pooling capabilities are used, the web applications can realize performance
improvements of up to 20 times the normal results.

With data sources, most user requests do not incur the overhead of creating a new
connection because the data source can locate and use an existing connection from
a pool of connections. When the request is satisfied and the response is returned to
the user, the resource returns the connection to the connection pool for reuse.

For example, for IBM Predictive Customer Intelligence, set the minimum value to
1000 and the maximum to 3000.

Web container configuration
Web container configuration settings can improve IBM Predictive Customer
Intelligence performance.

Enable servlet caching

The server caches servlet output during application execution. A cache entry
contains not only the output, but also the side effects of the invocation. These side
effects include calls to other servlets and metadata about the entry, such as timeout
and entry priority information.

Web container custom properties

For the HTTPQueueInboundDefault property, there are two settings:

Maximum pool connections
The number of connections that are expected to be responded to by the
application server. Ideally, this value should be equal to or more than the
number of clients that are expected to use the system. The maximum
number that can be set is 20000.

Maximum persistent requests per connection
Persistent connections specify that an outgoing HTTP response should use
a persistent connection instead of a connection that closes after one request
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or response exchange occurs. A performance boost can be achieved by
increasing the number of persistent connections that are allowed on a
single HTTP connection.

Logging and performance monitoring
For IBM Predictive Customer Intelligence, turning off logging and performance
monitoring in a production environment can improve performance.

Tune IBM Unica for Predictive Customer Intelligence
You can improve performance of IBM Predictive Customer Intelligence by
modifying settings for IBM Unica.

EHCache configuration settings

EHCache is the built-in cache manager for IBM Unica Interact that is used to
improve performance. It is possible to configure the settings that are used by
EHCache to optimize its value for the runtime server group.

The number of sessions in memory depends on the following factors:
v The expected number of sessions per second.
v The total amount of time each session is supposed to last.

For example, if you expect 50 sessions a second, and each session is expected to
last 20 minutes, then modify the settings to support 60,000 sessions at a time.

Java Serialization API rather than SOAP API
For IBM Predictive Customer Intelligence, the Java Serialization API provides
better throughput and a shorter response time than the SOAP API.

Threads for interactive flowcharts
Every interactive flowchart requires at least one thread to run.

IBM Predictive Customer Intelligence, set the MaxNumberOfFlowchartThreads value
to be at least the maximum number of concurrent users that are expected on the
IBM Interact client. And set the MinNumberOfFlowchartThreads value to be the same
as the maximum value. Set the MaxNumberOfProcessThreads value to be at least the
MaxNumberOfFlowchartThreads.

For example, set the MaxNumberOfFlowchartThreads and
MinNumberOfFlowchartThreads to 500. And set MaxNumberOfProcessThreads to 550.
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Appendix H. Administration tool and product portal reference

The administrative tools and portals for IBM Predictive Customer Intelligence are
located in several locations.

Access information for the tools and portals is provided in the following table.

Table 21. Administration tool and product portal reference

Administration tool or portal
and description URL or location

WebSphere Integrated
Solutions Console

The WebSphere Integrated
Solutions Console is the
administration tool for
WebSphere.

The WebSphere Integrated
Solutions Console is running
on each node computer where
WebSphere is installed.

Use the console to start and
stop applications.

http://server_node_name:9060/ibm/console

Where server_node_name is the name or IP address of a
node computer where WebSphere is installed.

Leave the User ID box blank.

IBM Cognos Configuration

Use IBM Cognos
Configuration to configure
settings for IBM Cognos
Business Intelligence.

/opt/IBM/cognos/c10_64/bin64/cogconfig.sh

IBM Cognos Configuration is installed on the Business
Intelligence (BI) node computer.

IBM Cognos Connection

Use IBM Cognos Connection
to access reports.

IBM Cognos Administration

Use IBM Cognos
Administration to configure
IBM Cognos BI, such as add
data source connections and
set security.

http://bi_node_name/ibmcognos/

Where bi_node_name is the name or IP address of BI node
computer.

IBM SPSS Collaboration and
Deployment Services
Deployment Manager

Use IBM SPSS Collaboration
and Deployment Services
Deployment Manager to
configure IBM SPSS server
settings.

http://analytics_node_name:9080/config

Where analytics_node_name is the name or IP address of
Predictive Analytics node computer.

The default user name is admin.

The default password is admin.
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Default users for an express deployment
The following user names and passwords are used in an express deployment of
IBM Predictive Customer Intelligence.
v On the data node computer:

– The IBM DB2 administrative user name is dasusr1. The password is dasusr1.
– The IBM DB2 instance owner user name is db2inst1. The password is

db2inst1.
– The IBM DB2 fenced user name is db2fenc1. The password is db2fenc1.

v On the Analytics node computer:
– The SPSS user name is admin. The password is admin.

108 IBM Predictive Customer Intelligence Version 1.0.0: Installation Guide for Linux Operating Systems



Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
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Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr.
Ottawa, ON
K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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This Software Offering does not use cookies or other technologies to collect
personally identifiable information.

Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “ Copyright and
trademark information ” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
v Microsoft, Windows, Windows NT, and the Windows logo are trademarks of

Microsoft Corporation in the United States, other countries, or both.
v Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,

Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

v Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

v UNIX is a registered trademark of The Open Group in the United States and
other countries.

v Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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